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Introduction
RaptorMed is a patient management software package originally designed for the 
unique needs of birds of prey. It was created and developed by Dr. Dave Scott and the 
staff at the Carolina Raptor Center in Charlotte, NC in 2009. It has since been expanded 
to handle any type of wildlife of zoo patient including aquatics.

It is very easy to use, requires very little in the way of computing resources and has a 
very long list of useful functions and features that are designed to improve staff 
efficiency and the quality of care. In addition, because there is powerful database 
running behind-the-scenes, the data that is collected in the system is now completely 
searchable. With RaptorMed, you can "go paperless" as there is no need for traditional 
paper records anymore. 

Here is just a short sample of the many things that RaptorMed does: 

• Track daily treatments and feedings 
• Schedule medications and procedures 
• Auto-calculate drug dosages 
• Track the exact location of every animal 
• Track each patient's problem list 
• Track weight and growth curves
• Monitor physical therapy and feather check results 
• Store all imagery files and lab results
• Generate all sorts of historical statistics 
• Estimate the cost of care for a patient 
• Produce all federal and state reports automatically 
• Produce Bandit reports automatically
• Manage volunteers
• Track inventory
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The main screen
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The main screen
Besides the main menu, the main screen is divided into four areas: 

• The filter controls that determine which animals are displayed in the animal list.
• The animal list
• Filter controls that determine which enclosures are display in the enclosure list.
• The enclosure list. The enclosure list can be hidden and restored by pressing the Hide 

enclosure list and Show enclosure list links (arrows).

Displaying certain animals with the filter controls
The filter bar allows the patient list to be filtered by various attributes including: 

• Id/name - This allows a single animal to be found either by id number or by name. If 
entered, all other attributes are ignored and only the specified animal will be listed.

• Species group - The represent broad categories of species. They can be user-
defined and can be, for example, avian, avian:raptor, avian:songbird, mammal, 
mammal:rodent, etc.  

Animal filter controls

Animal list

Enclosure list

Enclosure filter controls
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• Species - You can choose a species from 
the list or press the Species link to use the 
Species Lookup Tool. This displays the 
each species with it’s abbreviation, common 
name, scientific name and species group. 
You can sort by any column by clicking on 
the column heading.  Select a species and 
press the Ok button or simply double-click 
on one.

• Status/Disposition 
• Admission date or Final date - Select All, 

Today, or specify the number of days in the 
past.

• Location - Choose to view animals in only 
one specific location or all locations.

• Spill - If this feature is enabled, you can filter 
by the oil spill event that this animal is associated with. Spill events are tracked  with 
the Spill manager.

• Active patient status - View only active and/or inactive patients. An active patient is 
defined as one that has the Active patient checkbox checked. This is typically used to 
flag patients that are acutely injured and still in need of more hands-on attention.

Once the desired search parameters are entered, press the Search button and the 
patient list will be filled appropriately.

The Refresh button is used to refresh the patient list 
from the database. This should be used if certain 
changes are made at another computer. For 
instance, if a new patient is added or moved to a 
new location on another computer, the data needs to 
be refreshed from the database before it will display 
properly.

The animal list
The patient list displays all patients that match the currently applied filter parameters 
described above.  The list is sortable by clicking on each column.  The patient id, 
species, location and various other important data fields are displayed for each patient. 
The Special column displays abbreviations for some of the more important check box 
attributes that can be selected for each patient.  Specifically,

The patient status codes are:
------------------------------------------
DOA - dead on arrival
EOA - euthanized on arrival
D24 - died in the first 24 hours
E24 - euthanized in the first 24 hours
D - died after 24 hours
E - euthanized after 24 hours
Reh - currently in rehab
R - released
PR - permanent resident
T - transferred
ESC - escaped
COA - client-owned animal

For day-to-day use, it is 
usually best to display 
patients of all species and 
status equal to Reh or PR. 
This will display all active 
patients.
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• RWF - Release where found
• NOT RWF - NOT release where found
• FS - Feed separately
• NR - Non-releasable
• LPT - Live prey test required
• SWF - Staff will feed
• Gr - Group of animals

Click here for more information on the check box attributes.

To access an animal record, simply double-click on it.

The following commands are available from by right-clicking on an entry in this list:

• Edit treatment plan 
• Add new record entry
• Edit patient info
• Show reminders - All upcoming reminders will be displayed in a popup window.
• Paperwork - RaptorMed can do all sorts of paperwork for you automatically.  This 

includes sending various notifications to your US FWS agent or creating a non-
releasability letter.

• Maintenance
• Delete this patient - Although this should not need to be done often, this command 

allows you to remove a patient from the system. This is typically only needed if a 
patient was added accidentally.

• Clear this patient’s treatment plan - This is only needed if there is a problem with 
this animal’s treatment plan that is causing the program to malfunction. This should 
rarely, if ever be needed.

• Unlock this patient’s chart - This allows a previously locked chart to be unlocked 
and therefore be edited again.

• Split group - see Spitting Groups for more information.
• Assign to team (if Teams are enabled on your system)
• Show species info page - An informational page on the web will be displayed for this 

patient’s species.  Note that these information pages need to be configured for each 
species.  See Species for more information.

• Cage cards and printouts - There are several choices here to allow various patient 
cage cards and daily log sheets to be printed.

• Goto location - this will automatically scroll the Enclosure list to the location that 
currently contains this animal.

Shift-right click on a patient 
on the main screen to get 
a quick “Snapshot” that 
displays the weight profile 
as well as the last weight 
and date and any of the 
Special attributes listed to 
the left.
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The enclosure filters
You can specify that only enclosures for a specific curator/aquarist or department (if 
enabled) can be displayed. The filter control area also has a Goto field that can be used 
to scroll the Enclosure list directly to a specific location. This is helpful in instances 
where you have many enclosure or enclosures with many animals.

The enclosure/location list
The enclosure\location list displays each enclosure or location. Each location has an 
expandable/collapsable list itemizing each animal in that location.  You can access the 
enclosure’s log or an animal’s chart by double-clicking on the appropriate item in the list. 

The following commands are available from by right-clicking on an entry in this list:

• Record group treatment 
• Enclosure log
• Show census - Displays a small popup the 

summarizes that different species in the 
enclosure. This is particularly useful for 
aquariums.

• Update census
• Delete last group entry - Deletes the last entry 

made for each patient in the specified enclosure.  
This can be used in case a group entry was made 
incorrectly or accidentally.

• Edit group treatment 
• Show weight trends
• Add reminder 
• Cleaning and watering - This command allows you to record various cleaning/

maintenance actions for location/enclosure. This data is displayed on the Enclosure 
cleaning and maintenance report. 

• Edit cage/location properties
• Cage summary - This report concisely summarizes all animals in the specified 

enclosure.  It includes the id, band information, species, age, days in rehab, and 
whether the animal is marked as Release Where Found. It also includes a list of 
problems. This report can be printed and is handy when going to a specific enclosure 
to evaluate animals for release.

• Group operations
• Assign to team (if Teams are enabled on your system)
• Habitat census report (if enabled)

The Summary Snapshot
Pressing CTL-S on the main screen will produce the Summary Snapshot screen.  It 
shows admissions data and will graph monthly admissions for the last thee years. Each 
month in the chart is composed of three shaded bars. The left-most represents 2 year 

General Workflow
--------------------------------

1. Add a patient
2. Setup treatment plan
3. Print treatments sheets
4. Do your treatments
5. Record your treatments
6. And start all over again
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ago, the center one represents last year and the right-most bar is for the current year. 
Click outside the Snapshot scree to dismiss it.
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Adding a new patient/animal
To add a new patient, select Edit ▶ Add new patient from the main menu.

The New patient form has three tabs.

• Tab 1 - Animal Information: id, species, age, etc.
• Tab 2 - Location Information: where the animal was found, collected and/or 

transferred from.
• Tab 3 - Miscellaneous information: a short history, any donation information, etc.

Animal Information
The next patient Id is automatically selected.  Although possible, you should almost 
never have a need to change this id.  You can choose a species from the list or press 
the Lookup link to use the Species Lookup Tool. This displays the each species with 
it’s abbreviation, common name, scientific name and species group. You can sort by 
any column by clicking on the column heading.  Select a species and press the Ok 
button or simply double-click on one.

Click here to pull 
the lat/lon from 
the RaptorMed

Google Map
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The Admission date and Species are mandatory.   The species can be chosen from 
the abbreviation list or you can press the Lookup link to choose the species by their 
common names.  The Date of Birth (DOB), Age and Sex can be specified at this time.

Location information
Although many of these fields are optional, enter as much as possible as some of it may 
be required for various state and federal reports.  There are fields to enter information 
about where and when the animal was found. In addition, you can enter information (the 
Presented by/transferred from fields) about where 
this animal may have been transferred from (i.e. 
another rehab organization).  Information for either 
address (where found and presented by) can be 
retrieved from the Address Book by pressing the 
Lookup from address book links.  You can save 
the information in the Presented by/transferred 
from fields as a new contact by pressing the Add to 
address book link.

You can copy contact/address information from the 
Where found fields to/from the Presented by fields 
by pressing the left and right arrow buttons.

Click here for more information on the Address Book.  

You can specify the exact location for where the patient was found by manually entering 
the coordinates in the Lat/Lon fields.  You can also pull the exact coordinates from the 
RaptorMed Google Map.  To do this, load the Google Map into your browser.  Find the 
location on the map and left-click on the location.  Now, back in RaptorMed, press the 
Google Map button and the coordinate fields will be filled in automatically for you. Click 
here for more information on the RaptorMed Google Map.

If enabled, you can select an oil spill event that this animal is associated with. Once 
you select a spill, all the Found Location fields, including the latitude and longitude, will 
be automatically filled in.  Spill events are tracked using the Spill Manager.

Miscellaneous information
Additional information that can be entered in this section includes a short history, the 
name of the person who transported, who admitted the animal, details about when the 
animal was captured, the cause of injury and if any donation was made at the time of 
admission.  

The cause of injury and information about any donation made at the time of the 
admission can be recorded.  The initials/name of the person admitting the animal can 

If configured properly, the 
system will automatically fill in 
the county and zip code when 
you choose a city from the pre-
filled list or when you manually 
type in a value.  This applies to 
all forms that allow you to enter 
city as part of an address or 
location.
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also be entered. The actual time of day that the patient was admitted is automatically 
stored and is displayed in the Patient Info window.

Record information about any donations including the amount, type (check, credit card, 
cash) and details such as the check or credit card number.  The data in this field is NOT 
encrypted so you should not record the entire credit card number here.

If enabled on your system, you can also record information about how the animal was 
collected. This is useful when collecting aquatic animals for an aquarium.  Press the 
Collection details link and a form will appear that allows you to specify random details 
about the collection, the method used (i.e. dipnet, hook and line, etc) as well as the 
depth and water temperature. 

The Release where found check box can be selected to indicate that this patient is 
supposed to be released where it was found or if the finders indicated interest in being 
involved with the release.

When the Ok button is pressed, the new patient is added.  

At this point, the patient is in the system, but the 
following needs to be done in order to complete the 
entry:

• The physical exam findings and problem list should be 
entered.

• The patient’s location/enclosure must be specified.
• The treatment plan must be specified.

Viewing the patient chart
The patient chart is accessible by double-clicking on the animal in either the patient list 
or the enclosure/cage list.  The chart is divided into three sections:

• The Patient Summary - This section displays a patient overview and includes things 
such as the admission date, species, the age, and the number of days in rehab. It also 
shows the problem list, where the patient was found and any other special notes.

• The Action Bar - This section has a series of links to various functions that allow you 
to edit the patient’s information or treatments as well as manage the problem list, add 
reminders and also to add new record entries.

• The Medical Record Entries - This section has each record entry listed with the most 
recent at the top. Each entry includes the date and time it was made, the initials of the 

All live animals 
must have a valid 

location and 
treatment plan 

specified.
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person making the entry as well as the patient’s location when 
the entry was made. Each entry 
also displays the patient’s weight, 
body condition score and food 
leftovers if specified, in addition to 
the actual text of the entry.  The 
system can be configured to show 
only the most recent entries. For 
example, it may only display the 
last 12 months of entries by default.  
To see the entire set of entries if 
they are not already displayed, 
scroll to the bottom of the chart and 
press the Display entire record 
link.

• Any attachments such as image 
files or other documents, as well as 
any lab results are embedded 
directly in the entry.  To view an 
image or any other attachment, just 
single-click on it.  If it is an image file, it 
will be opened in a separate viewer 
window. If it is another type of file such 
as a Word document, it will be opened 
in the appropriate application, 
assuming the application is installed on 
the computer.  

The Action Bar

The Action Bar has the 
following choices that 
allow you to make record 
entries, view data and 
charts, and setup treatments.

Patient info
This function allows the patient’s basic information to be modified.  Click here for 
more information.

 Summary

 Action Bar

Record entries

This will either be 
the organization’s 
logo or the optional 
image that was 
declared to be an 
ID photo

Shift left-click to 
zoom on a 

particular area.

Right click on an image to
------------------------------------

• Export the image to a file
• Change the image type and 

description.
• Delete the image
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New entry
This function allows you to add a new entry to the medical record.  Click here for 
more information.

Treatment plan
This function allows you to modify this patients individual treatment plan. Click 
here for more information.

Problems
This function allows you to manage a patient’s problem list. Problems can be 
added and removed.  An initial date and end date can be specified and each 
problem can be marked as pending or resolved. Click here for more information.

Historical data
This function allows you to view and graph many types of data including imagery, 
weight profiles and laboratory test results.  Click here for more information.

Finder/Collection info
View/edit the information about where this animal found or collected. A form 
similar to the New patient form will appear with fields for entering information 
about where the animal was found and/or about where it may have been 
transferred from.

Add reminder
This function allows you to set reminders for this patient. Click here for more 
information.

View reminders
This function allows you to view all existing reminders for this patient. Click here 
for more information.

Samples
This function allows you to view all samples stored for this patient. Click here for 
more information.

Export
This function allows you to export a patient’s record.  All lab results or exported 
automatically.  Images can also be optionally exported. The export can use one 
of two formats:

• HTML - this produces a web page that can be viewed or emailed.
• XML - this produces a file that can be later loaded into another RaptorMed 

database. This is very useful when transferring an animal to another 
facility.  See the Import animal record command for more information.
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You will be prompted to select a location on the computer into which to save the 
export. 

• If you elected to export the images/attachments then a folder named after 
the animal’s Id will be created in the specified location and the medical 
record and all attachments will be copied there.

• If you elected to not export the images/attachments, then a single file will 
be created in the location specified.

Invoice
This function allows you to generate an invoice for client-owned animals. You will 
be prompted for a date range and all procedures recorded in the Procedure log 
will be tallied to generate the invoice.

Cost estimator
This function creates a estimate summarizing the cost of care that this patient 
has received.  Click here for more information.

Search
This function allows you to search for any word or phrase in the entire chart.  
After entering the search text, any matching text will be highlighted and visible as 
you scroll down in the chart.  There are Find/Next buttons that you can press to 
advance to the next occurrence of the search text.

Print cage card
This function allows you 
print a card suitable for 
hanging on the patient’s 
kennel or enclosure. 
The format, layout and 
information that is 
printed on the cage 
card is completely 
customizable. Contact 
customer support for 
assistance.

Print cage sheet
This function prints a full-page cage sheet which has space for daily entries.

Summary
The function allows for a patient overview or summary to be recorded. This is a 
quick place to become familiar with familiar with a patient’s history. Of course, 
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this summary is only as good as how well it is kept up-to-date.  This summary 
may also be printed on some reports, depending on your configuration.

Program log
This function allows you to record and track program usage for an animal.

Print Rx
This function, if enabled, this will print a prescription sheet for the specified 
patient.  Only prescriptions that have an Until date in the future will be printed.

Print Lab Request
This function, if enabled, this will print a lab test request form for the specified 
patient.

Vet/special entries
This function will list all the record entries that are marked as either Special or 
Veterinary entries.  You can double-click on any entry in the list to go directly to 
that entry.  For some clients, this function will list all entries that are marked as 
New visits.

View options
This function allows you to filter which type entries 
are viewed. For instance, you can view only the 
Veterinary entries or only the Important events. 
• Normal entries are for everyday records.
• Vet entries are typically used by veterinary 

staff to record important medical information.
• Important events are used to record 

information about important events.
• New visits are used in clinical situations for a 

new patient visit. These are typically used for 
client-owned animals that live offsite with an 
owner or caretaker are visiting the clinic for an 
appointment.

• Requires review is for an entry that is made 
that requires review and approval before the 
entry is considered finalized.  RaptorMed 
allows for user logins that can only make 
entries that require review and also user logins 
that have the ability to review and approve 
entries made by other users. See User 
Manager for more information.

• User-defined entry types - The system also 
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allows for entry types that are user defined. Please contact customer service 
for more information.

You can also choose how many entries are viewed. By default, the system will 
only view the last 12 months of entries.  This default value can be set to any 
number of months or it can be overridden completely by checking Show entire 
history. The Show resolved problems option will display all problems whether 
they are resolved or not.

Attributes
Any number of random attributes can be stored for an animal.  An attribute can 
be a name/value pair or simply just a keyword. Each attribute can have an 
optional date associated with it.  Some attributes are automatically generated by 
the system to track certain events or conditions but you are free to add any 
number of attributes to track any type of data.  These attributes can then be 
searched or queried later when attempting to mine your data.  Some examples of 
attributes are:

Name Value Date

OWCN notification date 2016-03-02

Voriconazole trial

Body temp 85 2016-01-01

Body temp 86 2016-01-02

To display an animal’s attributes, press the Attributes link in the Action Bar.
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You can press the + to add an attribute, press the - to delete the selected 
attribute, or double-click on an attribute to edit an existing attribute. The Attribute 
editor dialog allows you to choose a Name from the pre-filled list or enter a new 
name.  The Value and Date are optional and depends on the type of data you 
are trying to store.

Vaccine History
This function allows you to view this animal’s vaccine history. It displays the 
vaccine given, the date, the form/manufacturer, the volume and the route of 
administration.  This data is created by using the Vaccine link in the Medical 
Record Entry form.
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Changing an animal’s 
basic information
Basic patient information such as 
species, sex, age, etc. can be 
viewed and changed by clicking on 
the Patient info link in the Action 
Bar on the patient’s chart.  The most 
common changes mde involve the 
patient’s location and status (i.e. In 
Rehab, Released, Died, etc). 

The following fields on this form are:

• Id - This number is automatically assigned by the system and should rarely or never 
need to be changed.

• Name - This field is primarily 
used for resident animals 
that may have a name.

• Species - The species is 
indicated by an abbreviation.  
For birds, the 4-letter 
abbreviations specified by 
the USGS Bird Banding Lab 
(BBL) are typically used, 
although, this is not 
absolutely required.  For 
non-avian patients, you can 
used any scheme that works 
for you.  Many facilities use 
the genus/species as the 
basis of the abbreviation.  
For example, the opossum is Didelphis virginiana and its abbreviation could be DIVI.  
Another option is to create easily recognized abbreviations for a species so the 
opossum could be OPOS.  Any abbreviation can be used as long as two species do 
not have the same abbreviation. The species abbreviations are defined in the Species 
Editor.

• Morph - Any color morphology or subspecies information. This is useful for species 
such as screech owls that have different feather colors.

The input format for all date fields is either 
yyyy-mm-dd or mm-dd-yyyy. You can 
separate the year, month and day with 
either a - or a /. For example, July 12, 2012 
would be

 2012-07-12 or
07/12/2012

You can always double-click in any date 
field to bring up a calendar date picker.
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• DOB - If an actual date of birth/hatch is known, it can be entered here. In this case the 
actual age in years will be calculated and displayed.

• Age In - The age on admission.

• Age - The current age. This age should be updated as necessary. For example, all 
birds traditionally gain a year of age on Jan 1.

• Sex - Male, female or Unknown.

• Admission date - The date of admission

• Final date - The date when the patient is finalized (i.e. release, died, euthanized, etc.).

• Status - The current patient status. The basic choices are described in in this table. 
There may be additional status codes that are specific to your installation.

Status Description

DOA dead on arrival

EOA euthanized on arrival

D24 died within 24 hours

E24 euthanized within 24 hours

D died after 24 hours

E euthanized after 24 hours

Reh currently in rehab

R released

PR currently a permanent resident

T transferred

ESC escaped

COA client-owned animal such as a 
falconry bird

• Location - The patient’s current location. It is very important that this be kept up-to-
date.
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• Band/color/unique characteristic - Any characteristics that uniquely identify this 
patient. This is useful to tell this animal apart when in a group. It can be an ID band 
number, an ear tag number, an ink pen color mark, or even an unique behavioral trait.  
When the animal is in a rehabilitation setting, this can be a temporary band or marker. 
This field is also used for a permanent marker when and if an animal is released.

• Auxilliary marker - USGS auxilliary markers are recorded in this field. Refer here for 
more information.

• Microchip - Microchip/PIT tag numbers can be recorded here.

• Expected release date - The date you expect this patient to be ready for release. 
This is used in the Event Planner to plan release events.

• Team - The team that this patient is assigned to. This feature may not be enabled on 
your system.

• Summer/year-round weight - The ideal weight (in grams) for this patient. This value 
is used for the summer or year-round if a winter weight is not also specified.

  
• Winter weight - The ideal weight (in grams) during the winter months. 

• Husbandry notes - Any unique husbandry related notes for this animal.

• Away from/to - Dates during which this patient will be away from the facility. This is 
primarily used for resident animals that are out on programs. In these cases, feeding 
instructions for these patients will not be printed out on the daily treatment sheets. 
These dates are ignored unless the Away/offsite checkbox is checked (see below).

• Training level - Used for resident animals that are trained or worked by handlers. 
Each patient can be assigned a training level. This setting is used in the Handler 
Training Log which allows you to keep track of which handlers have been trained with 
which animals.  The training level ranges from Beginner to Master. If you leave this 
field blank, then this animal will not be included in the Handler training function.

• Keywords - Each patient can have keywords assigned to them for easy retrieval at a 
later date. For example, a patient that is part of specific treatment trial can be tagged 
with a special keyword.  You can enter any random text or press the + button and 
choose from a pre-defined list of keywords.  Any number of keywords can be added 
and should be separated with commas.  A quick search for patients based on many 
characteristics including keyword can be quickly performed using the Advanced 
Search Tool.
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• Notes - This field is used to store any information that you want to keep readily 
available. This information is displayed at the top of the patient’s record in the 
Summary area and printed on the daily treatment sheets.

• Release event -  You can use this field to store information about an upcoming 
release event that this animal is scheduled for. You can manually enter information 
here but this field is typically filled in automatically by the Event Planner.

• Age and sex-related characteristics - This field can store information about any 
characteristics that help identify the age or sex of this patient.  For example, “adult 
plumage, dark brown iris” might be entered for an adult hawk. This information is 
displayed later when creating a Release/Banding Record as it helps fill the age and 
sex fields on that form correctly.

The check boxes
There are also a whole list of check box choices that can be made.  When checked, a 
short description of each is displayed at the top of the patient’s record in the Summary 
area and printed on the daily treatment sheets. The options are summarized in the 
following table.  The entries marked with an * are for informational purposes only and do 
not affect the behavior of the program.  Note that the check boxes are arranged in a few 
groups such as Alerts, Resident animals, etc. These groupings are merely 
organizational and are for clarity. They do not indicate that only resident animals, for 
example, can use the check boxes in the Resident animal section. 

name description

Critical* This patient is critical. 

Easily stressed* This patient is easily stressed.

Bleeding tendency* The patient has had a bleeding tendency on previous blood collections.

All meds PO Used for patients that are not yet self-feeding. Used to ensure that all 
meds are given manually.  Birds with this option selected will 
automatically be marked as a GRABBER on the daily treatment sheets.

Carry and weigh in box* This patient should be carried and weighed in a box. Typically used for 
young patients/orphans that are delicate and should be handled as little 
as possible.

Anesthetic risk* This patient has had anesthesia problems in the past.

Do not band* This patient has had issues with id bands on its ankle in the past. This is 
a reminder to not replace a band while in rehab or prior to release.
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name description

Food aggressive* This patient is food aggressive and can be dangerous when feeding.

No water* This patient should not be given water for some reason such as a foot 
bandage.

Body grab only* This patient should not be grabbed by the legs. Typically used for long-
legged avian species or a patient that should not be grabbed by the legs.

Don’t grab left leg* This patient has an injury to the left leg.

Don’t grab right leg* This patient has an injury to the right leg.

Escape artist* This patient has a tendency to escape so be careful when entering its 
enclosure.

Undergoing PT This patient is currently undergoing physical therapy.  Selecting this 
option will place this patient on the Physical Therapy Report.

Contagious* This patient is potentially contagious.

Easily imprintable* This patient is easily imprintable. Useful for young vultures or any other 
easily imprintable species.

Long term feeder For internal use only

Exclude from web page This patient’s chart should not be displayed on the RaptorMed web page. 

Neonate/orphan This patient is a neonate/orphan.  Depending on how your system was 
configured, this may be used to determine where this patient prints on the 
daily treatment sheets.  This setting is also used to include patients on the  
Orphans ready for transfer report.

180 days reported This patient has been in rehab over 180 days and this status has been 
reported to appropriate authorities. This checkbox can be checked 
manually but it is also set automatically by the Greater than 180 days 
report.

Active patient This checkbox can be used to indicate if this is an active patient and not 
one that is in the final stages of rehab.  This checkbox can be used in the 
Active patients report ( Reports ▶ Active patients ) and in the active/
inactive patient filter on the main window.
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name description

Feed/treat separately This option is used to indicate animals in a group are to be treated/fed 
separately. Typically, patients that are housed individually are treated 
individually using their individual treatment plan.  Likewise, patients in a 
group are treated as a group and use a Group Treatment.  By checking 
this box, this behavior can be overridden such that all patients in a group 
will use their individual treatment plans.  This is useful when there are 
patients that are housed in a group but require individual treatments.  
Note: the actual effect of this check box depends on your configuration. In 
some cases, this check box is ignored and in others cases, it is only 
recognized if ALL patients in a specific location have the check box 
checked.

Aggressive/dangerous* Used for animals that are aggressive or dangerous. 

Foster parent This animal is used as a foster parent. This checkbox can be used in 
various reports.

Disposition letter sent Used to indicate that a disposition/status update letter has been sent to 
the finder.

Locked This animal’s chart has been locked and cannot be edited.

Temporary* This is a temporary patient.

Resident This is a resident animal. When PR is chosen for the animal’s status, this 
checkbox is automatically checked. This seems redundant but this keeps 
the animal’s status as a past resident when and if the animal’s status is 
changed (for example if it dies or is transferred).

Away/offsite This patient is away or offsite. If checked, the Away From/To dates are 
used to determine if an entry for this patient should be printed out on the 
daily treatment sheets.

Staff will feed These animals are to be fed by special staff and will appear on a special 
“Staff will feed” treatment sheet. This option may not be used in your 
configuration.

In rehab This is used to indicate that a resident animal is sick or injured and should 
be temporarily treated by the rehab hospital staff.  This may affect where 
this animal is printed on the daily treatment sheets and this is highly 
dependent on how your installation was configured.

Geriatric* This is an old patient. This distinction is subjective and depends on the 
individual and the species.

Needs cope This avian patient needs to have its beak coped. It will appear on the 
Cope report.
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name description

Non-native This patient is not a native species. This setting can be automatically 
configured for each species using the Species Editor. These patients are 
typically ignored when generating year-end report for each state and for 
the USFWS.

Cold-intolerant This patient is cold-intolerant. It will appear on the Cold-intolerant 
patients report.

Program animal This animal is used for educational programs. Animals with this check box 
selected can have program usage records recorded using the Group 
Program Log function.

Group of animals This animal is not an individual. It represents a group like a school of fish 
or a collection of insects. See Group animals for more information. 

Needs imp This avian patient needs to have its feathers imped and it will appear on 
the Imp report.

Waiting for molt* This bird’s feathers are damaged badly and cannot be imped.  It will likely 
be a long-term patient while it waits to molt new feathers.

Needs molt chamber* This bird’s feathers a damaged badly and cannot be imped.  Checking 
this option puts in on the waiting list for a molt-chamber, if available.

Release where found* This patient should be released where it was found. This may be because 
the finder/public requested it be returned when ready for release or 
because it is in the best interest of the patient.

Finder present at release This indicates that the finder would like to be present at the release.

Do NOT release where 
found

This patient should NOT be released where found. This is typically for 
cases where the patient was injured intentionally (i.e. gunshot).  This flag 
will be set automatically when you select one the illegal causes of injury 
(click here for more information).

Has placement This patient is non-releaseable but permanent placement has been found.  
These patients will not be shown on the Patients that need placement 
report.

NR This patient is non-releaseable and permanent placement has not been 
found.  These patients will be shown on the Patients that need 
placement report.

NR on arrival This patient was non-releasable on arrival. Typically this option is 
selected along with the NR option.  If selected, this patient will be 
excluded from any release rate calculations made by RaptorMed. This 
option is used for patients that are clearly non-releasable on arrival but 
are either unique or rare and are worth keeping for placement.
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name description

Release approved* This patient has been approved for release.  This may also be referred to 
as Transfer approved when the patients are orphans that have been 
approved for transfer to another facility to complete the rehab process.

Needs live prey test This patient needs a live prey test prior to release. It will be shown on the 
Patients that need live prey test report.

Does NOT need live prey 
test

This patient does not need a live prey test prior to release. This can be 
used for patients (i.e raptors) with eye damage. Typically, many of these 
would need vision and/or live prey testing before release. This option can 
be used for those patients that have eye damage but are deemed fit for 
release without further testing. These patients will not be shown on the 
Patients that need live prey test report.

Needs falconer eval This raptor needs a falconer evaluation prior to release. These patients 
will be shown on the Falconer eval waiting list report.  This is typically 
used for species such as peregrine falcons that may require special flight 
training prior to release.

Needs ophtho consult This patient needs a ophthalmogist’s evaluation prior to release. These 
patients will be shown on the Ophtho consult waiting list report. 

Band return This patient has had a band report after release. It will appear on the 
Band reports report. These patients typically will have a Band Report 
record attached to there chart.

Treated with 
chemotheapeutics

This animal has been treated with a chemical that makes it non-
releasable. This is typically used for fish in an aquarium setting. These 
animals will appear on the Chemotherapeutic exposure report.
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Chapter 2
Making record entries
Entering lab results, procedure reports and examinations
Tracking the patient’s problem list
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Making medical record entries
Medical record entries can be made for an individual patient, for all patients in the same 
enclosure (click here), or for multiple enclosures all at once (click here).  Which method 
you use depends on whether the patient is being treated individually or as part of a 
group.

Individual entries
Medical record entries can be a combination of hand-typed, 
text, text that is automatically inserted by the system, 
images, and results of lab tests or examinations.  This 
function is accessed by clicking on the New entry link in 
the Action Bar on the patient’s chart.

The weight and body condition score (BCS) are entered at 
the top. Both fields are optional.  The weights can also be 
entered in kilograms.  To enter a weight in kilograms, 
append a “k” after the weight value as in “1.2k”. The weight can also be entered as  
total weight - a tare weight.  So if an animal is weighed in a box that weighs 500 
grams and the combined weight is 1300 grams, you could enter “1300-500” in the 
Weight field and RaptorMed will do the math for you.

The initials of the person making the entry, the date and time, are required fields. Note 
that the date and time fields are filled in with the present date and time so you may need 
to change these if you are making an entry for something that happened early that day 
or on an entirely different day altogether.

If enabled, there may also be fields to enter the Amount fed and the Leftovers. Using 
these entries allows for food intake and leftovers to be graphed in the Historical Data 
Viewer.

You can enter any amount of text in the main text area or you can cut and paste text in 
from any other application.

Double-clicking on any of the entries in Area 1 will automatically insert a predefined 
block of text. This is useful to quickly enter text that is used repeatedly.  The list of 
choices in this area is configurable and can be changed at any time.  See the Text 
template editor for more information.

RaptorMed uses a 
24 hour clock so 1 
PM is 1300.  Times 
can be entered with 
or without a colon 
separating the hours 
and minutes.
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Enter weight, body condition score, 
amount fed, and leftovers here

Drag and drop image and other 
files here

Enter or paste text here
Click here to insert predefined blocks of text

Click here to enter lab results, etc.

1

2

Click here to enter text using customizable forms

3

Choose the type of 
entry:
* Normal
* Important event
* Vet entry
* New visit (useful for 

client-owned animals
* Requires review - entries 

that need to be reviewed 
and approved before 
becoming finalized.

The Entry type field is useful in order to designate some entries as more important or 
special in some way. Using View Options, you can filter the display to only see certain 
types of entries.  

You can have RaptorMed alert you if a 
newly added weight varies by a specified 
percentage from the previous weight or if 

the new weight is outside an “ideal” weight 
range.  You can also have the system send 
an email or text message to a designated 

person if such an event occurs.
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Double-clicking on any of the entries in Area 2 allows you to enter lab results, 
treatments and many types of other data.  Click here for more information.

Double-clicking on any of the entries in  Area 3 (Forms) allows you to enter data using 
any number of user-defined data entry forms.

Any file can also be dragged onto the form and added as an 
attachment.  For image files, 
the JPEG or PNG file type 
are 
recommended.  
Other file types, 
such as Word 
or Excel files, 
pdf’s or other 
image file types 
can also be 
dragged and 
dropped onto 
the medical record. 

When you drag and drop and 
image file, the Image import 
window appears. This allows you to 
choose the image type.  Here are 
some possible choices:

• Radiograph - the default choice
• Zoomed radiograph
• Endoscopic image
• ID photo
• Microscopic image

Double-clicking on the Record treatment item in Area 2 (the red 
arrow in the picture) will automatically insert the patient’s complete 
treatment plan into the record.  This includes everything that was 
specified in the treatment plan as well as drug concentrations and 
amounts.  All you have to do is modify it to match what was actually 
done. This allows you to make a very accurate and complete entry 
in almost no time at all. 

Image 
dimensions

Resize by   
percentage 
or specify 

the width in 
pixels 

Flip horizontally or 
vertically or rotate 

90 clockwise

Left-click and drag 
mouse with shift key 
pressed to crop the 

image

Add a description 
or choose from 

the keyword list by 
pressing the + 

button
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• Photograph
• Scanned document

When a image is marked as a Radiograph, it will be used by the Cost Estimator when 
calculating the total cost.  For this reason, make sure you set the image type correctly.  
Otherwise, the cost estimate will be inaccurate.  It is not uncommon to save a zoomed 
or cropped version of a radiograph that focuses on an area of interest. For these 
images, choose Zoomed radiograph for the image type so these images will not be 
counted by the Cost Estimator as another radiograph.

When the image is marked as an ID photo, it will be displayed at the top of the patient’s 
chart. This image is displayed as a square with a resolution of 150x150 pixels so any 
image you import of this purpose should have the same aspect ratio and should ideally 
be an even multiple of this resolution for the best viewing.

You can add a description to your images and/or choose from the keywords list by 
pressing the + button.  Adding a description allows you to find images easily later using 
the Image Search tool.

When you add an image, the Image import tool allows 
you to resize, crop, rotate and flip the image.  It is often 
recommended that images be resized before saving, 
especially if taken with a modern digital camera since 
those images tend to be quite large and have many more 
pixels than are actually needed for a good-quality image.  
A good recommendation for photographs is to crop and 
resize an image to a width of about 1000 pixels. This still 
provides good quality and saves storage space.  When 
you drag and drop the image, the dimensions of the 
image will be displayed.  Radiographs can also be 
resized but it is important to store a much more higher resolution image.  3500 pixels in 
width is a good recommendation.

To resize the image, check the Resize image check box and then choose either By 
percentage or By pixels.  By pixels is usually more helpful. Then enter the desired 
width (such as 1000 pixels).  The image aspect ratio will be preserved.

You can flip and rotate the image as well by pressing the corresponding buttons. Finally, 
you can crop the image by left-clicking and dragging a box on the image preview while 
holding the Shift key down.  The program will automatically select the upper-left hand 
corner of the image if you click within 10 pixels of the corner. This makes it easier to 
select the upper-left corner. Once you have the image the way you want it, press the Ok 
button. If you made a change that you don’t like, simple press the Cancel button and 
start over.

Do not resize 
radiographs as you 
usually want to 
maintain the highest 
image quality so that 
you can zoom in on 
small details later.
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Group entries
To make an entry for all animals in a specific enclosure, right click on the enclosure in 
the Enclosure list on the main screen and choose Record group entry from the popup 
menu. Or you can right-click and choose Group Operations ▶ Record Group Entry. In 
the second case, you will first be prompted to choose which animals to apply this entry 
to.  

Whichever way you choose, a form will appear. It will display what the currently 
proposed treatment is.  You may simply modify the existing text or completely replace it 
if necessary.  Be sure to enter your initials and the correct date and time.  After pressing 
the Ok button, a separate and identical entry will be made in the chart of each of the 
patients in this enclosure.  Click here to see how to set up a group treatment.

Note: The proposed treatment is for each patient. So be sure to edit the entry to reflect 
what was really done. For example,  if you plan to feed animal 25 grams and there are 4 
animals in the group, you should record that 100 grams were fed.  Always remember to 
multiply the treatment food amounts by the number of animals in the location. Otherwise 
the resulting entries made in each animal’s chart will not be correct.

30



You can press the Insert patient list link and a list of each animal’s id, band/tag, age 
and sex information will be inserted (purple arrow).  This is helpful when you need to 
record notes about each patient in an enclosure.

You can auto-insert any of the predefined text templates by double-clicking on an entry 
in the list on the left-hand side of the screen (orange arrow). See the Text template 
editor for more information.

The amount of leftovers can be recorded and you can also specify whether this is a 
special entry (such as a vet entry or an interesting even) or just a normal entry.

Multiple enclosure entries
To enter 
treatments for 
multiple 
enclosures at 
once, choose 
Tools ▶ Multiple 
cage entry from 
the main menu.  A 
form will appear 
that contains a 
spreadsheet that 
lists all the 
enclosures that 
have at least one 
patient in them.  
You can filter the list by Nocturnal or Diurnal and by Rehab or Resident.  There are 
columns that allow you to enter the initials of the person who did the treatment/feeding, 
the actual treatment or food provided, the leftovers (if any) and the time that the 
treatment occurred.

There is also a column for the weight that can be 
filled in if the patient was weighed.  Obviously, it only 
makes sense to fill in the weight if the enclosure has 
only one patient.

The Initials, Food, and Time columns must all be 
filled in. If not, then the row in the table will be 
ignored.  This is convenient as you may only want to 
record treatments for some of the enclosures.

Note: Multiple enclosure 
entries are most useful for 
simple cases.  Entries for 
more complicated cases 
are best handled as 
described above.
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As a time-saver, you can right-click on a cell in the Initials and Time column and 
choose Fill down to copy the current cell’s value down to the bottom of the column. 

Once you have entered everything, press the Save button and the records for each 
patient in each of the Locations in the table that you filled in will be updated.

Entering results of laboratory tests and examinations
Results for laboratory tests, examinations, surgery, transfers and a whole host of other 
important records can be attached to a patient’s file by clicking on the appropriate links 
listed vertically on the left side of the medical record entry form.  Results for the 
following lab tests, exams, procedures can be added to a patient’s record:

Examinations
• Physical exams
• Eye exams
• Biometric measurements
• Flight evaluations
• Feather checks

Laboratory tests
• CBC
• PCV/TS 
• Serum chemistries
• Protein electrophoresis
• Blood lead
• Fecal exams
• Cytologic exams
• Miscellaneous samples and tests
• Urinalysis

Procedures
• Surgery reports
• Endoscopy reports
• Physical therapy
• Advanced imagery

Miscellaneous
• Release/band use reports
• Transfer reports
• Band reports
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• SOAPs
• Dose calculations
• Fluid calculations
• Enrichment
• Training
• Live prey test
• Invoices and the procedure log
• Vaccines
• Wounds

Physical exams
The physical exam form allows you to make entries for any abnormal finding.  There are 
different sections that cover all body areas and systems.  When you have completed 
your entries, press the Ok button and your entries will be formatted and inserted into the 
patient’s record.  It is usually recommended that you leave an entry blank if the 
corresponding area or system is normal.  Alternatively, you may want to make an entry 
indicating that no problem was found to make it clear that the exam was completed 
thoroughly.  Note that the actual entry fields on the form depend on the species group 
the patient belongs to. In addition, the fields are customizable so the fields you see may 
differ from the screenshot.

You can also specify the patient’s 
weight, body condition/keel score, 
age and sex in the appropriate 
fields at the top of the form.  In 
addition, there is a link that allows 
you to specify the cause of injury 
and to edit the problem list.
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Eye exams
The eye exam form allows you 
to record your observations and 
to color code each eye to 
indicate the severity of the 
damage. The color coding 
scheme is very subjective, but if 
used consistently, it can be very 
effective in demonstrating 
changes over time.  The color 
codes range from red 
(completely blind) to bright 
green (perfect vision). There are 
fields to record the PLR and 
menace response as well as the 
results of a corneal stain.  The 
Notes fields are used to record any other finding including results of a fundic exam.

Biometric measurements
Biometric measurements can be recorded 
using this form.  The actual measurements to 
be recorded are based on the animal’s species 
group.  For example, you can record the 
weight, wing chord, culmen length and hallux 
length for a bird and you can record various 
carapace measurements for a turtle. 

If you enter a weight value, this value will be 
auto-copied into the parent medical record 
entry record as well. This is important and 
helpful because it is the weight that is recorded in the medical record entry that is 
automatically graphed in the Historical Data Viewer.
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Flight evaluations
Results of flight examinations can be 
recorded and scored using a color code.  
Scores for both the ability to fly and the 
sound level can be recorded.  The color 
coding scheme is very subjective, but if 
used consistently, it can be very effective in 
demonstrating changes over time.  The 
color codes range from red (unable to fly or 
very loud) to bright green (perfect/silent 
flight).

Feather checks
Records of feather condition can be 
recorded for the primary feathers and the 
tail feathers. The form is oriented as if 
the bird was laying on its back for the 
exam. So the left side of the form is for 
the right wing.  Each feather state is 
color-coded. Greens indicate better or 
good feather quality while yellows, 
oranges and reds indicate progressively 
worse condition.  The condition of a 
specific feather can be recorded simply 
by dragging a color from the color palette 
to the appropriate feather.

The feather colors default to gray/
unknown.  You can set them all to dark green/Ok by pressing the Set all to Ok link.

drag & 
drop
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CBC
Complete blood count results can be recorded including 
specific findings regarding hemoparasites, cell morphology, 
and platelets.  The percentages of each cell type must total 
to 100%.  It is important, although optional, that you enter 
the corresponding PCV/Hct, if known, as the actual white 
count can be adjusted up or down based on the PCV.  The 
following formula is used to calculate the WBC count:

! WBC count = WBC countobserved x PCV / 45

If the PCV is not supplied, then a correction will not be 
made.  If desired, you can also choose to disable this auto-
correction function.

Note: the PCV that is recorded here is NOT used to create 
the PCV graph in the Historical Data Viewer. The PCV 
graph uses the PCV value stored in the PCV record (see 
below). If desired, you can configure the system to 
automatically create a PCV record using the value entered on this form.

This form can also be optionally expanded to allow for the entry of various RBC indices.

PCV/TS
The packed celled volume (PCV), buffy layer 
and total solids (TS) can be recorded. The 
units for PCV and buffy are % and g/dl for 
TS.  A subjective interpretation of the plasma 
can also be recorded.  The PCV/TS values 
entered here a automatically graphed in the 
Historical data viewer.
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Serum chemistry
Blood chemistry results can be 
recorded using this form.  The 
actual fields present depend on 
whether the patient is a mammal or 
avian/exotic.  The source of the 
results can also be chosen from a 
configurable list.
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Protein electrophoresis
Use this record to store serum EPH 
data. You can specify each fraction 
as well as record notes about the 
source of the results, the sample and 
your interpretation.

Blood lead
Blood lead values can be recorded using this 
form.  The units (i.e. ug/dL or ppm) and the source 
of the results can be selected from a configurable 
list.
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Fecal exams
Results of fecal exams can be 
recorded with this form.  The list of 
choices is configurable.  To select an 
entry, double-click on the name of the 
parasite in the Choices list and it will 
be added to the Findings list.  To 
remove a selected choice, double-click 
on it in the Findings list.  If the exam 
was negative, simply leave the 
Findings list empty.  You can also 
specify the type of flotation as well as 
any random comments.

Urinalysis
Urinalysis results are recorded with this form. 
There are fields for the physical properties 
(such as color and clarity), biochemical dip-
stick tests, as well as a description of the 
sediment and your notes and interpretation.
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Cytologic exams
Cytologic exam results can be 
recorded using this form. The 
list of Stains is configurable. 
There are fields to enter the 
Location of the sample, your 
Findings and the Diagnosis.

Miscellaneous samples and tests
Samples and test results that do not 
fit into one of the above mentioned 
pre-defined categories can also be 
recorded in RaptorMed.  After 
double-clicking on the Samples & 
tests choice, a list of current samples 
will be displayed.  You can add a new 
one by pressing the + button or 
removed the selected one by 
pressing the - button.  You can edit 
the selected sample by double-clicking on it.  

When you add or edit a sample, you must select the 
Sample type and Collection date.  There is also an 
optional Notes field. You can add a new test by 
pressing the + button or remove the selected one by 
pressing the - button.  You can edit the selected test 
by double-clicking on it.

Note: Samples can only be 
added to existing medical 
record entries. Therefore, 
you cannot create a new 
entry then add a sample to 
it before saving the entry.
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The test result form allows you to specify  
the Test, the Lab, the Submission 
date, and any Results.

The sample form lists all tests run on that 
sample.  
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Surgery reports
Surgical reports can be recorded 
using this form.  The actual 
procedure performed is chosen 
from the Procedure list. The list of 
choices is configurable.  The 
Complexity field allows you to 
specify if this was a Major or 
Minor procedure and this choice 
is used by the Cost Estimator 
when calculating the patient’s total 
cost. You can also record the 
Total time and the actual 
Surgical time. This is very useful 
to track trends and gauge your 
surgical skill over time.  There are 
also fields to record the 
Anesthesia protocol, your 
Monitoring methods, Pre-
medications, Fluid therapy, 
Antibiotics, and any Post-op 
medications. Each of these fields is pre-filled with commonly-used text and this text 
can be edited or replaced completely as needed. There is also a large edit field to 
record the actual procedure.

Endoscopy reports
Endoscopic procedures can be recorded 
using this form.  There is a field to record 
the location that was scoped (i.e. 
trachea, air sac, etc), a field to record 
the anesthetic protocol used, and a field 
to actually record the procedure and 
findings as well as a diagnosis if there 
was one.
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Physical therapy
Physical therapy sessions can be recorded with this 
form.  You can select which limb received the 
therapy as well as the beginning and ending angles 
for each of the major joints.  This data is graphed in 
the Physical therapy chart.

Release/band use records
Releases (with or without a 
federal band or other 
identification device such as 
an ear tag) are recorded with 
this form.  The Id type list 
allows you to choose the 
type of identification device. 
There are several options 
(including “None”) to choose 
from.  The Id number field is 
used to store the unique 
identification number that is 
on the leg band or ear/wing 
tab.

If you enter a band number 
that is already in use, you 
will be prompted to continue. 
Since these bands are 
unique, this should typically 
not happen.

If you choose “Leg band”, 
then additional fields will be 
enabled that allow you to 
enter all the information that 
is required to be submitted to 
the USGS Bird Banding Lab 
(BBL).  RaptorMed can then create a file 
that can be imported automatically by the 
BBL’s Bandit Software to submit your 
banding data. Click here for more 

Click here to 
load a location 
from the 
address book

Click here to 
pull the lat/lon 
from the 
RaptorMed
Google Map
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information on how RaptorMed integrates with Bandit.  If your facility does not federally 
band your avian patients on release or for non-avian patients, this form will be simpler 
and will not have all the fields shown here.

If you do submit banding data to the BBL, it is very important that you make the correct 
entries in this form or your data may not be accepted.  This is especially important for 
the How sex determined, How age determined, Id number, and Band size fields.  
The Age-related notes field will contain any notations that you made in the Patient info 
form, usually when the patient was first admitted.  These notes can help to serve as a 
reminder for how the age was determined. Select the type of tracking device in the 
Tracker type list and enter any additional details in the Details field.

This form also supports optional Auxiliary Markers and these can be entered on this 
form if necessary.  Double-click in the field and a form will popup that allows you to 
choose the code and colors for the marker.  The field at the bottom will turn green when 
you have entered a valid marker code.

You can also enter information about any tracking devices that may have been attached 
prior to release.

You should also enter the location where the release took place, including the latitude 
and longitude, if known.  If the animal was released at a known site in the Address 
Book, you can import all the relevant information automatically by pressing the 
Address Book button and selecting the appropriate site.  Click here for more 
information on the Address Book.

You can also pull the exact latitude and longitude coordinates from the RaptorMed 
Google Map.  To do this, load the Google Map into your browser.  Find the location on 
the map and left-click on the location.  Now, back in RaptorMed, press the Google Map 
button and the coordinate fields will be filled in automatically for you. Click here for more 
information on the RaptorMed Google Map.

You can also record whether the release site was on public or private land.
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Band report records
These records are used to record a 
band report.  That is, when a banded 
animal is spotted or recovered in some 
way after release.  The Condition and 
How found codes are usually stated 
on the official band reports that you 
will receive from the Bird Banding Lab.  
If the report came directly from the 
person who found the banded animal, 
choose the most accurate codes for 
the situation.  

Advanced imagery
A record of 
advanced imaging 
studies can be 
recorded with this 
form.  You can 
record notes about 
the type of study 
and the equipment 
used as well as 
how the patient 
was anesthetized 
and your findings.

Click here to 
pull the lat/lon 
from the 
RaptorMed
Google Map

In cases where the animal is 
readmitted as a new patient, it is 

important to attach the band report 
record to the original patient’s chart, 

not the new patient’s chart.
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Transfer records
All transfers should be recorded with this 
form.  This is very important as this 
information is required on the 
year-end US Fish and Wildlife Service 
(USFWS) report and may also be required on 
your state reports.  Animals are transferred 
for several reasons including:

• For continued care with the hopes of 
eventual release.

• For permanent placement if non-releasable.
• Transferred live or dead for scientific/

education use.
• For falconry or propagation programs.

You must enter the information for the 
recipient including the permit number.  If the 
animal was transferred to a facility in the 
Address Book, you can import all the 
relevant information automatically  by 
pressing the Lookup from address book 
link and selecting the appropriate facility.  
Click here for more information on the 
Address Book.

Note: When transferring a patient, the patient 
status should be set to T and the Final date 
should be set appropriately.  Click here for 
more information on finalizing a patient.  The 
one exception is when the patient is deceased 
(with status of DOA, D, D24, EOA, E, or E24) 
and it is transferred dead for education or scientific purposes. In this case, the status 
should be left unchanged and should not be changed to T.

The Reason choices are:
• Release
• Continued care
• E/S - educational/scientific study
• F/P - falconry/propagation
• Other
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You can press the Set as default link to save the current choices. These will be used as 
the default values the next time you create a Transfer record.  This is helpful if you often 
transfer animals to the same place.
 
SOAPs
Clicking on the SOAPs item inserts a pre-formatted 
block of text into the medical record that has a 
SOAP entry for each unresolved problem (click 
here for more on Problems).  This simply provides 
a shortcut so that you don’t have to type as much. 
Note that use of this feature, and SOAPing in 
general, is completely optional and may not be 
necessary at your facility.

Dose calculations
This feature is used to 
document how drug doses were 
calculated.  This is generally 
only useful in an educational 
setting (i.e. a vet school) where 
students are required to show 
their math.  After clicking on the 
Dose calc item, a form appears 
that allows you to specify the 
drug and the problem for which 
the drug is meant to help. There 
is also a field that is pre-filled 
with the dose calculation 
formula.  The student must 
edit the formula and enter the 
actual numbers to show the 
calculation.  It is meant to be a manual process so that the student is forced to do the 
calculation.  The areas indicated by the arrows in the screenshot are to be replaced with 
actual numbers.
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Fluid calculations
This tool does quick fluid calculations for you.  
After clicking on the Fluids item, the fluid 
calculator window will appear. This form allows 
you to select the dehydration level, how quickly 
you want to replace the deficit and how often you 
want to administer the fluids. It will then perform 
the calculation and insert the corresponding fluid 
therapy plan into the patient’s chart.  Note that it 
assumes a value of 50 ml/kg/day for 
maintenance.  If you have entered a weight in the 
patient’s record, then it will be pre-filled in the Weight field.  Otherwise, you have to 
enter a weight manually.

Enrichment
Enrichment activities can be recorded here. There are multiple fields to record various 
aspects of the activity including the type of enrichment and time. Click on the + to the 
right of the 
What was 
used? field. 
This will 
produce a 
hierarchical 
list of choices 
for you to 
select from.
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Training
The training form allows 
you to record many 
aspects of a typical 
training session.

Invoices and the procedure log
The procedure log allows a ledger of procedures with optional prices to be recorded. 
This data can then be used to create an invoice.  To log procedures, select the 
Procedures link. Note that this may be displayed as Invoice, depending on how your 
system is configured. A screen will be displayed that allows procedures  to be selected 
from a hierarchical list on the right-hand side. 
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Double-click to select an item. It will be added to the list on the left-hand side. You can 
edit both the entry and the cost or you can edit/remove an item that was added 
incorrectly.

Depending on your setup, there may be fields to enter Anesthesia time, procedure 
time as well as to check off which procedures were actually performed under 
anesthesia.

The data entered here can be used later to generate an Invoice.

Vaccines
This tool allows you to record vaccinations. A form will 
appear that allows you to choose the vaccines from a 
list.  Fill in the date (which will default to today), the route 
of administration and the volume (for each injection). 
Press Ok and an entry will be added to the medical 
record.  You can then select the Vaccine History link in 
the Action Bar and see a list of all vaccines given.

Wound reports
Wound reports allow you to record characteristics about wounds using a visual tool.  
The wound reports use a template which includes a in image with one or more areas 
identified as common wound sites.  A good example would be the feet of a bird of prey 
where bumblefoot lesions are commonly found or the shell of a turtle which can often be 
cracked from roadside trauma.  To create a wound report, double-click on the Wounds 
entry in the list on the left-hand side of the Medical Record Entry form.  This will open 
the first wound report template that your system is configured with. If your system is 
configured with more than one wound template, you can right-click on the Wounds 
entry and choose from a list.  Please contact customer service for help in setting up 
wound templates.  The Wound report form will appear. It displays a graphical image of 
the affected body area with + marks indicating specific locations where a recording can 
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be made.  If you click on a + mark, the location will be marked a selected (red arrow).  
You can then select the wound’s size, severity and the amount of swelling by adjusting 
the corresponding slider controls. Your choices will be reflected by a “bull’s-eye” symbol 
at the appropriate spot.  The size slider determines the diameter of the bull’s-eye 
symbol, the wound severity slider sets the outer color and the swelling slider sets the 
inner color.

You  can make a record for a lesion at one or all of the locations specified by the + 
mark.  When you are done, press the Ok button.  The wound report  will be saved and 
an image of the wound report will be captured and stored as a thumbnail as is the case 
with all other image attachments.

Wound reports and the associated image can be viewed or deleted at any future date 
but they cannot currently be edited.  Multiple wound reports can also be simultaneously 
in chronological order in the Historical Data Viewer.
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Problems
You can maintain a  problem list for each patient. This list is displayed on the animal’s 
main chart at the top in the Summary area.  Problems can be added and removed.  An 
initial and end date can be 
specified and you can mark if a 
problem has been resolved.  A 
green check indicates that the 
problem is resolved while a red x 
indicates it is still an issue. If no 
problems have been identified, 
then “NO PROBLEMS 
RECORDED” will be displayed.

To add or edit problems, click on the Problems link in the Action Bar.

The current list of 
problems is displayed to 
the left. You can right-click 
on an existing problem to 
remove it, set the initial or 
resolved dates or to switch 
its status.  When a 
problem is marked as 
resolved, the Resolved 
date is automatically set to 
the current date.

You can add a new 
problem from a list of pre-
configured problems by double-clicking on any of the entries in the list to the right.  If 
there is a problem not currently in the list that you would like to add, just enter it in the 
edit field in the lower right and press the + button.

There are few problem choices that have special meanings:
• Toxin - Lead - Be sure to use this choice for all confirmed lead poisoning cases as 

this information is used in optional Part E of the US FWS year-end report.
• Orphaned - Be sure to use this choice (and only this choice) for all healthy orphans as 

healthy orphans are reported differently in the Bandit report that goes to the US 
Geologic Survey when reporting birds that are released with official federal bands. 
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Note: since this is a “normal” condition and not necessarily a true problem, these 
entries are marked as “resolved” with a green check when added.

• orphan - For the Washington state year-end report, make sure that this word appears 
in at least one problem associated with each orphan patient.

The system can be configured to treat various problems as “non-problems” and will 
mark them as resolved with green check mark instead of a red X when added.  This is 
useful when you want to record various issues and conditions such as “Orphaned” that 
really are not true problems.  Please refer to the Technical Reference Manual for more 
information.

You can also choose the cause of injury from a list of pre-configured choices. There are 
a few choices (such as gunshot) that are considered illegal causes of injury by the US 
Fish and Wildlife Service (USFWS).  When one of those choices is selected, a 
reminder will automatically be created to remind you to notify the USFWS.  In addition, 
the patient will be marked as “Do NOT release where found”.

The system can assist you in sending an automated update email to USFWS when 
there is a patient admitted as a result of an illegal cause of injury. Click here for more 
information.
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Chapter 3
Individual treatments
Group treatments
Printing treatment sheets
Enclosure logs and treatments
Reminders
Favorites
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Treatments
You must specify a treatment for each patient.  Each day, treatment sheets are printed 
and the appropriate treatments are printed based on the date and the time of day.  It is 
not uncommon to print sheets multiple times a day as a patient may need different care 
in the morning compared to at night.  It is also very common 
for a treatment plan to change during the day and for 
patients to be moved to a new location.  A patient either has 
an individual treatment or is part of a group treatment.

Individual treatments
All patients kept in an inclosure by itself will use its 
individual treatment plan. This treatment plan is accessed 
via the Treatments link in the Action Bar at the top of the patient chart.  
The Treatment form appears and it has the following main categories:

• Food
• Fluids
• Antibiotics, anti-

fungals, etc
• Analgesics, NSAIDs, etc
• Eyes
• Ears
• Other meds
• Vaccines
• Miscellaneous - 

radiographs, blood 
collection, surgery, 
physical therapy, 
bandage changes, 
clinician consults, etc.

Each section has many 
different choices and these 
choices are configurable based on what 
your facility needs.  Therefore, your 
screen may differ in appearance than 
what is shown here. The medication 
choices are configurable using the Medication Editor and all the other choices are 
configurable using the Treatment Options Editor.

Each choice has a check box that allows the treatment to be selected.  In general, each 
treatment may have a frequency list to allow you to select how often (i.e. SID, BID, TID, 
etc.) the treatment needs to be done. There may also be options for setting specific 

All active patients 
must have a valid 
location and 
treatment plan.

Click on these 
check boxes to 

select a treatment.

The system knows 
this patient’s weight

The dose is automatically 
calculated for you.

Set an Until 
date here

Click here to see the 
actual dosages that 
the are programmed 

into the system.
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dates or for setting a date to continue the treatment until.  Remember that you can 
double-click in any date field to bring up a calendar date picker.  Many drugs allow you 
to enter multiple future dates. You can enter 
each one manually by typing the date or by 
using the calendar date picker in each field. 
You can also auto-set the dates by right-
clicking on any one of the date fields and 
choosing Set dates on interval.  A small 
window will appear that allows you to set the 
start date, the number of dates and the 
interval in days between dates.  When you 
press Ok, the date fields will be automatically 
filled in.

If the treatment option is a medication, the dosage will be automatically calculated for 
you if the patient’s weight has been entered and if your formulary contains a dosage for 
this drug. See the Medication Editor for more information.

In the Food section, there a many different options for feeding, including leaving food in 
the enclosure (Food), force feeding (Force feed), tube feeding (Tube feed), etc.  For 
most options, you can simply type in the details of the diet. For the simple Food in cage 
option, you may also be able to choose from a list of pre-defined diets that are 
appropriate for the particular species.  Please contact customer support for details.

There is also an option called NPO which stands for “nothing per os”.  This means that 
nothing is to be given orally and is usually used on surgery days so that a patient is not 
fed before anesthesia.  If this option is checked, then all food entries will be ignored on 
the specified days.

In the Fluids section, there is also an option called Periodic which allows you to specify 
that fluids be administered on specific dates rather than one or more times every day.

There is a special field 
called Other. This field 
is used to schedule a 
treatment that isn’t 
already built-in to the 
system.  By selecting 
this option, you can 
enter any custom text describing the treatment.  You can either enter a specific date in 

BID keyword
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the date field or you can put the SID, BID, TID keywords in the actual text description to 
program a treatment that is to be performed at least once or more times per day.  The 
Requires grabbing is used to indicate if the patient needs to be handled in order to 
perform this treatment.

Click the Show dosages link to view the dosages that are being used by the system for 
this patient.  The dosages are taken from a formulary that has been configured for the 
animal’s species group. There can be any number of individual formularies. For 
example, animals in the avian:raptor species group may use a different formulary than 
animals in the mammal:rodent species group. See the Medication Editor for more 
information.

If enabled, the system will auto-insert a summary of the treatment plan into the medical 
record after the treatment has been modified and saved.

Group treatments
When a patient is part of a group of two or more animals, the treatment/feeding will be 
specified by a group treatment plan.  In these cases, the animals are usually on more 
of a maintenance-type plan where individualized treatments are no longer required. To 
create or edit a treatment plan for a group, right-click on the enclosure/location in the 
Enclosure list on the main screen.  Choose Edit group treatment from the popup 
menu. Press the Yes button when prompted if you want to proceed.  A window will 
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appear that allows you to enter the treatment plan 
and to select the frequency (i.e. SID, BID, etc).  Note 
that the treatment plan that you enter is for EACH 
animal in the enclosure.  

So, for example, you may have an enclosure with 
three screech owls. The plan may call for 25 grams 
of mouse daily for each animal.  This exact plan and 
the number of animals will be printed on the daily 
treatment/feeding sheets.  You must realize that the 
enclosure actually requires 25 x 3 = 75 grams since there are three birds. 
Press the Ok button when complete. You can always go back and edit this treatment 
plan later.

If an animal that is in a group needs a special treatment, there are three ways to 
accomplish this:
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Click here to 
append a copy of 
this entry to each 
animal’s individual 
chart.  If enabled, 
there are also 
options to choose 
specific species 
or species groups 
to auto-append 
the entry to. There 
is also an option 
to append the 
entry to other 
enclosure logs.

Drag and drop image and other 
files here

Enter or paste text here
Click here to insert predefined 
blocks of text

Click here to enter water quality 
test results, etc.

1

2

Choose the type of entry:
* Normal
* Important event
* Vet entry
* Requires review - this 

type of entry requires 
review and approval 
before being finalized.



1. Use a reminder. Reminders can be 
added for a patient to schedule a 
procedure or treatment. They can 
be scheduled for a specific day or 
set to repeat daily until turned off.  
Click here to see how to setup a 
reminder.

2. Mark the patient as “Feed 
separately”. This will tell the 
system that, even though this 
patient is in a group, the patient’s 
individual treatment plan should be 
used.  Click here for more 
information about setting this option.

3. You can set up a virtual cage. For example, if there 
are 2 animals in CageA and they need to be treated 
individually, you can create CageA-1 and CageA-2 
and move each animal into one of them.  You, of course, realize that they are 
actually the same enclosure but this “tricks” RaptorMed into thinking they are 
individuals. In this case, each animal’s individual treatment plan will be printed out 
separately on the daily sheets.

Printing treatment sheets
The treatment sheets that print out are designed to provide a clear and concise 
synopsis of the patient and the treatment that has been planned for it.  The actual 
format of the sheets that are printed have been customized for your facility so they may 
be different that what is shown in this example.  The following areas and pieces of 
information may be available on your sheets.

1. How often does this patient need to be treated each day?
2. Does the patient need to be grabbed in order to perform the treatment? The 

system automatically determines this from the treatment plan.  This is helpful as 
you can utilize less experienced staff and personnel for the “non-grabbers” and use 
your more experience people for the “grabbers”.

3. The patient id
4. The species
5. The age
6. The current location
7. Admission date
8. The problem list
9. Other important notations

Currently, if one patient 
is marked as Feed 
separately, then all 
patients in the 
enclosure must also be 
marked as such.
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Double-clicking on the Record treatment 
item in Area 2 (the red arrow in the 
picture) will automatically insert the 
enclosure’s complete treatment plan into 
the record.  This includes everything that 
was specified in the treatment plan as well 
as drug concentrations and amounts.  All 
you have to do is modify it to match what 
was actually done. This allows you to 
make a very accurate and complete entry 
in almost no time at all. 



10. Weight history
11. The treatments that are required
12. An area to jot down notes
13. Check boxes to indicate that the treatment is done.  There is a checkbox to 

indicate the treatment was prepped, one to indicate it was actually performed and 
one to indicate if it was recorded in RaptorMed.

To print treatment sheets, choose Tools ▶ Print treatment sheets from the main menu.  
A window will appear that allows you to choose which sheets to print, if you want to print 
for today, tomorrow or any future date and it allows you to preview the printout before 
printing.  The actual appearance of your print selection form may vary as this feature is 
customized for your facility.

Note that it is good practice to print sheets for the next day at the end of each day.  This 
insures that you will have your treatment sheets ready the next morning.  You can never 
predict when you may have a printer problem or power outage so it is strongly 
encouraged that you print your sheets as part of your end-of-day procedure. 

The Preview option is helpful in that you can 
preview the treatments for a future date to help 
get an idea of how busy the day will be.

1 2 3 4
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Enclosure logs and treatments
Treatment plans for an entire enclosure can be setup and recorded in an enclosure log.  
When an entry or treatment is recorded, a duplicate entry can also be made in the 
individual chart for each animal in that location. This function is more versatile than the 
standard Group treatment function described above and is designed for organizations 
like aquariums that need may have complicated treatment and or feeding plans for their 
various enclosures. In general, you should use either the enclosure logs or the group 
treatments as there is not much reason to use both simultaneously. 

To access the enclosure log, right click on an location and select Enclosure log.  The 
enclosure log screen will be displayed.  It has a Summary Area at the top that includes 
various attributes and details for aquatic systems as well notations on when various 
maintenance and cleaning functions were performed.  There is an Action Bar below the 
Summary Area that allows you to

• View/edit the 
enclosure 
properties

• Create a new log 
entry.

• Edit the treatment 
plan.

• View water 
chemistry or 
environmental 
conditions data.

• Search for text in 
the log.

• Add or view the 
reminders.

• Jump to a specific 
Special entry.

• Filter the log to 
view only Special 
entries.

Summary Area

Action Bar

Log Entries
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The actual log entries are listed below the Action Bar with the most recent entry 
displayed at the top.

Adding an enclosure log entry
To add a new log entry, press the New entry link.  A form will appear that is very similar 
to the one that is used to create a new individual patient record entry.

You can enter any amount of text in the main text area or you can cut and paste text in 
from any other application.

Double-clicking on any of the entries in Area 1 will automatically insert a predefined 
block of text. This is useful to quickly enter text that is used repeatedly.  The list of 
choices in this area is configurable and can be changed at any time. See the Text 
template editor for more information.

Double-clicking on any of the entries in Area 2 allows you to enter lab results, 
treatments and many types of other data.  See below for more information.

Any file can also be dragged onto the form and added as an attachment.  For image 
files, the JPEG file type is recommended.  Other file types, such as Word or Excel files 
or other image file types can also be dragged and dropped onto the enclosure log.  For 
more information on importing image and document files, look here. 

The Entry type field is useful in order to designate some entries as more important or 
special in some way. Using View Options, you can filter the display to only see certain 
types of entries.  
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Recording enclosure maintenance
To record that an aquarium/system has 
been cleaned or disinfected, double-click 
on Cleaning/water change. A form will 
appear that allows you to select what was 
done (cleaned, disinfected, carbon 
change, etc) and to specify the amount of 
water changed as a percentage of the 
entire volume.  Enter the initials or name 
of the person responsible for the work and 
press Ok to append this to the enclosure 
log.

Recording water chemistry tests
To record a water quality test, double-click on 
Water chemistry.  A form will appear that 
allows you to enter values for many different 
parameters. The actual parameters that are 
listed depend on how your system is 
configured. In addition, the measuring units 
and what is considered a “normal” range can 
be set for each parameter.  Press Ok to 
append this to the enclosure log.  All the water 
quality data can be viewed and graphed as 
described below. 

Temperatures can be entered in either Celsius 
or Fahrenheit. You can specify the unit by 
appending a C or an F after the numeric 
temperature. If neither letter is used, the 
system assumes the unit that is set up as the 
default.
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Depending on your 
configuration, you may have a 
customized form that can 
auto-calculate various 
parameters.  For example the 
form shown at the right has 
lavender-highlighted fields that 
are automatically calculated 
based on the values entered 
in the fields near the top.  This 
can be a big time-saver as 
these calculations can be 
quite complicated in some 
instances.

Note: you can enter test 
results for multiple enclosures at 
once using the Bulk water quality entry tool.

Bulk water quality entry
This tool is accessed by choosing Tools ▶ Multiple enclosure water quality entry  
from the main menu. A form is displayed that allows you to entry water chemistry data 
for any number of systems.  Only aquatic system are listed. Enter the appropriate data, 
enter a date, time and the 
name of the person 
responsible and press the 
Ok button.  You do not 
need to enter data in each 
test column and entire rows 
can be skipped. Only enter 
the data that was recorded 
and needs to be saved.  
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Recording environmental conditions
Click on this link to record measurements for various conditions such as air temperature 
(ambient, basking, low), humidity as well as UV light levels.  A form will appear that 
allows you to enter values for many different parameters. Press Ok to append this to the 
enclosure log.  All the environment condition data can be viewed and graphed as 
described below.
Temperatures can be entered in either Celsius or Fahrenheit. You can specify the unit 
by appending a C or an F after the numeric temperature. If neither letter is used, the 
system assumes the unit that is set up as the default.

Chemical titration calculator
This tool can be used in aquatic 
environments to auto-calculate the amount 
of a certain chemical in order to raise it from 
the current concentration to a desired 
concentration.  It takes into account 1) the 
volume of the enclosure/system, 2) the last 
measured level for the drug or chemical in 
question 3) the selected concentration of the 
raw stock to be added and 4) the desired 
concentration.

To use this tool, select the chemical from the 
Drug list. The desired level and the current 
level will be filled in automatically if that 
information is available. Select a 
concentration from the Form list.  Press the 
Calculate button and the volume of chemical to be added will be displayed. To record 
this calculation/treatment, press the Record treatment button and an entry will be 
made in the enclosure’s log.

Insert animal list will automatically append a list of the animals in this location into the 
currently open log entry. The id number, band/tag information, name, age and sex will 
be inserted for each animal. This command is useful when you need to make an 
observation about each animal as this provides a nice placeholder or starting template 
of text for the entry.
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Creating an enclosure feeding/treatment plan
To setup the feeding/treatment plan for an enclosure, press the Treatment plan link.  
The Treatment plan form will appear that allows you to specify various types of food, 
medications and miscellaneous things like water changes and chemistry tests.  

The food can be setup in many different ways.  For example, you can choose to provide 
a different meal on each day of the week and you can schedule multiple meals per day.

For aquatic enclosures, you can also setup and schedule various medication and 
chemical treatments.  

The Miscellaneous section allows you to schedule various things like sunning, misting, 
and water changes.  For aquatic systems you can also schedule water chemistry tests.  
There is an Other category that allows any type of random task to be performed. Other 
(daily) is for something that needs to be done daily. There is another Other category 
that allows specific dates to be specified.

Be sure to check the box 
before any item on the 
treatment plan that you wish to 
select. For the various 
medications, you can select the 
treatment form (if there is more 
than one) and the frequency as 
well as specific treatment dates 
or an until date for medications 
that are done daily.  If properly 
configured, RaptorMed will 
automatically calculate the 
dose based on the desired 
dosage, the volume of the 
system and the concentration/
form of the medication.

To specify a date, just double-
click in any of the date fields 
and a calendar will appear that 
allows you to choose a date.
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Viewing water quality and 
environment conditions data
To view this data for an 
enclosure, press the Water 
chemistry or Environment 
conditions links.  A window will 
appear with two tabs. One tab 
displays the data in tabular/
spreadsheet form. The other tab 
graphs the data.

Jump to special entry
Press the Special/vet entry link. This will produce a list of special entries sorted by date. 
If you double-click on one, the log will jump down to the selected entry.

View options
If you click on this link, you can choose to view only the Special entries. This is very 
helpful when you want to filter out all the normal daily entries.  You can also choose 
whether to display the entire medical record or just the last x months-worth of entries 
You can also choose whether to display problems that have already been resolved.

Update census command
This command is available for a specific enclosure via the right-click menu in the 
enclosure list on the main screen. It will display a spreadsheet with the current species 
counts.  There is a column for you to record the new count for each species.  If the new 
count is less than the previous count, then you must also choose a disposition or status 
code in the last column.  Valid disposition codes are D, MIA, E, or ESC.  This can occur 

67



in an aquarium setting 
when some animals found 
to be missing or dead.  If 
the new count is greater, 
than the current count, the 
disposition column is 
ignored as it is assumed 
that the new animals are 
the result of internal 
procreation or are simply 
the result of a previous 
miscount.  If the count for a 
certain species is 
unchanged, then leave the 
New count field blank.
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Reminders
RaptorMed allows for reminders to be added to the system.  A reminder can be set for 
an individual patient, for an enclosure or general purpose reminders can be added for 
the facility as a whole.  Each reminder will be printed on the daily treatment sheets on 
the correct date.

Creating a reminder

To add a reminder for a patient, click the Add reminder link in the Action Bar on the 
patient’s chart.

To add a reminder for an 
enclosure, right-click on the 
enclosure in the Enclosure list on 
the main screen and choose Add 
reminder.

To add a general purpose 
reminder, choose Edit ▶ Add 
reminder from the main menu.

Enter some text describing the 
task and enter a date.  You can 
choose Once if you only want one 
reminder or you can have the 
reminder repeat any number of 
times by selecting Repeat and 
filling the number of times to repeat and the interval in days between repeats.  
These repeating reminders will begin on the date specified.

Additionally, you can create a reminder that will automatically repeat every day, on  
specific day of the week or on a specific day of the month.  These reminders will 
continue forever until deleted.

You can also choose an optional Category for the reminder and this allows reminders to 
be sorted in the Reminder Viewer.  The category can be anything and can indicate a 
type of task (e.g. rehab or maintenance), a person’s name or anything else that allows 
you to group or organize your reminders.

Viewing, editing and removing reminders

To view reminders, choose Reports ▶ Reminder viewer from the main menu.  A 
window will appear that shows your reminders. You can filter what to view by choosing 
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All, Today, Upcoming or Tomorrow from the When list.  You can also view reminders 
for a single enclosure/location by selecting from the Where list and you can choose to 
view only reminders of a certain category.  Finally, you can view reminders for a single 
animal by entering the patient id in Patient id field. After entering the id, press the 
Rerun report button to refill the list.

To edit a reminder, just double-click on it.  To view the chart for a patient listed in a 
reminder, double-click on the patient’s reminder with the SHIFT key held down.

You can push a reminder to tomorrow by selecting it and pressing the Push to 
tomorrow button.  This is handy for those days where you could not get everything 
done.

You can edit a reminder by double-clicking on it or by selecting it and pressing the Edit 
button.You can select multiple reminders by left-clicking and shift-left clicking.  You can 
then edit, delete or push them all simultaneously by pressing the Edit, Delete or Push 
buttons, respectively.  

If you are viewing reminders for a specific animal, then an Add button will also  be 
present that allows you to add new reminders.

You can sort the reminders by clicking on any of the column headers and you can print 
the currently displayed list of reminders by pressing the Print button.

As a shortcut, you can view all reminders for a single patient by clicking the View 
reminders link from the Action Bar in the patient’s chart.
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Favorites
Favorites are shortcuts to animals that you work with frequently or otherwise would like 
to have quick access to.  Any number of favorites lists can be created and animals can 
be added or removed to a list at any time. Choose Edit ▶ Favorites list from the main 
menu. A window will be displayed that 
shows each favorites list as well as 
the animals that are part of each list. 
To access an animal’s chart, just 
double-click on it. 

Right-click and choose Add new list 
to create a new list.  To add an animal 
to a particular list: select the list, then, 
in the Animal list on the main screen, 
right-click on the desired animal and 
choose Add to favorites list. Note 
that an animal can be on multiple 
favorites lists.

To remove an animal from a list, simply right-click on it and choose Remove this 
animal from list.  Note that a list will cease to exist if all animals are removed from it, 
so there is no need to delete or remove a favorites list.

The size and position of the Favorites list will be remember when it is closed and will be 
restored the next time it is opened.  It will also remember to expand the list to that was 
last selected.
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Chapter 4
The historical data viewer
The reports
! Physical therapy report
! Last weights report
! Weight trends report
! The Site Map
! Year-end reports
! Miscellaneous reports
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Historical data viewer
Press the Historical data link in the Action Bar on the patient’s chart to view all sorts of 
patient data.  A window with the following tabs will appear:

• Weight - Displays a graph of the animal’s weight and body condition score.
• Feathers - Displays a view of all the animal’s feather checks. The most recent is at 

the top.
• Imagery - Displays thumbnail views of all the animal’s imagery including photos and 

radiographs.  You can click on each image to display it in a larger view.  Click here for 
more information on viewing imagery.

• PT - Displays a graph of the animal’s physical therapy sessions.
• Eyes - Displays a view of all the animal’s eye exams. The most recent exam is at the 

top.

• Flight - Displays a view of all the animal’s flight evaluations. The most recent 
evaluation is at the top.
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• Wound records - Displays all the animal’s wound reports in a chronological order so 
that you can assess progress easily. 

• PCV/TS/Buffy - Displays a graph of the animal’s PCV/TS/Buffy coat measurements.
• CBC - Displays a graph of the patient’s CBCs.
• Blood chemistry - Displays a graph of the animal’s blood chemistry values. Since 

there are so many analytes that can be recorded, you must choose the analyte to 
graph from a list.

• Lead - Displays a graph of the animal’s blood lead measurements.
• Dose calcs - Displays all the animal’s dosage calculations.  Note that this feature may 

not be enabled on your system.
• Food intake - Displays a graph of the daily amount fed and the leftovers.  Note that 

this feature may not be enabled on your system.
• Group weight ranges - Often individuals in groups of animals cannot be uniquely 

identified. In this case, the lowest and highest weight in the group can be recorded 
and graphed. This allows you to spot trends without actually knowing individual 
weights. Click here for more information.

If you click on a point on the Weight, PCV/TS, CBC and Lead charts, the actual value 
and date will be displayed.  On many of the charts (including the Weight chart),  you can 
also choose the date range to display.

The Physical therapy (PT) chart displays the range of motion (ROM) for each major 
joint in the limb undergoing therapy.  There are separate charts for each each joint (the 
elbow and the wrist in the case of a wing).  Each PT session is represented by a vertical 
orange bar. The bottom of the bar indicates ROM angle at the start of session and the 
top of the bar indicates the angle at the end of the session.  The blue band represents 
the ideal angle for the specific joint.  For the typical raptor, the ideal angle is 140 
degrees for the elbow and 180 degrees for the wrist.  A healthy bird should have very 
short orange bars that are contained completely within the blue band.  The left side of 
the display is the oldest and the right side is the most recent.
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In the example in 
the screenshot, 
the elbow had 
poor ROM that 
then progressed 
to near-perfect 
extension. The 
wrist was very 
good from the 
beginning.  As 
you can see, the 
display enables 
you to determine 
very quickly 
whether the ROM 
is good or bad 
and whether or 
not you need to 
continue physical therapy.
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Reports
The Physical Therapy Report
This report allows you to review at-a-glance all patients that are currently undergoing 
physical therapy (PT).  A patient will be included in this report if it’s Undergoing PT 
checkbox is checked.  Click here for more information.  The report shows the patient id, 
the species, the current location, the last PT date, and the date of the next scheduled 
PT session. 

If a next PT is not scheduled, the box will be highlighted.  For an individual patient, 
physical therapy is scheduled on the patient’s individual treatment plan (click here for 
more information).  If the patient is part of a group, then future PT sessions must be 
scheduled with a Reminder since patients in a group do not use their individual 
treatment plans. In these cases, the Next PT column will say Reminders.  Left click on 
the Reminders text and the list of upcoming reminders will be displayed.

No upcoming PT has 
been scheduled

This patient is in a group. 
Left click here to see any 

reminders.
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The Last Weights Report
This report allows you to quickly determine 
which patients have not been weighed 
recently.  Choose Reports ▶ Last 
weights report from the main menu.  You 
can choose to view:
• Either patients currently in rehab or 

resident animals
• To view only those patients that have not 

been weighed in a specific number of 
days

• Only animals taken care of by a specific 
curator.

The report displays the patient id, name/
band information, the location, species, and the last weight/date.  It is a good idea to 
check this report periodically to make sure a patient doesn’t “slip through the cracks”. 
Note: resident animals in aquatic environments are not included in this report as 
animals in aquariums typically do not get weighed very often.

The Weight Trends Report
Right-click on a location in the Location list and choose Show weight trends.  This 
command displays the weight trends for all patients in the enclosure.  The patient’s id 
number is displayed to the right of the trend line.  The actual weight can be viewed by 
clicking on any point.  The overall trend is color-coded.  

• Green means that the trend is generally increasing. 
• Gray means that the trend is mostly flat. 
• Red means that the trend is generally decreasing.

Note that recent changes are weighted more heavily than past changes. 
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You can select the number of days to display, you can filter the chart to only show lines 
based on their color and you can also choose to display only juveniles or mixed ages.  
The age filter currently only works for avian species whose current age is listed as L or 
HY.

The Site Map
Choose Reports ▶ Site viewer from the main menu to view the Site Map.  This shows 
a graphical view of your facility with each enclosure indicated by a color code.

• Red - under construction
• Orange - this enclosure is dirty and should not be used
• Yellow - occupied by at least one patient 
• Green - empty

Click on each colored indicator to see a popup summary of the enclosure. 

Shift-left click on any spot on the map to save the coordinates for later recall in the 
Location Editor (click here).
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Right click and choose Reload to have the map redrawn.  This is useful if you make a 
change to a location and want to see the changes reflected in the Site Map without 
having to close it and re-open it.

Right click and choose Show feed 
order to display the route specified by 
each enclosure’s Feed order setting.  
To hide the route, right click and 
choose Hide feed order.

Click here for more information on 
configuring locations and enclosures.

Some organizations have a multi-level 
site map.  Small thumbnails are 
displayed for each level. Click on a 
thumbnail to view an enlarged view of 
the level or area.  Each individual 
location is indicated by a colored dot. 
Click on the dot to bring up the 
Enclosure log for that specific location.

Resident Animal Summary
This report creates a concise summary 
of all the current residents animals. The 
report includes the animal’s name, id, 
species, location, sex, age, a list of the 

The feed order route
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current problems and any other annotations that were recorded in the patient’s Notes 
field (click here for more information on the Notes field).

Active Patients
This report displays a list of all patients that are considered “active”.  The report is 
configurable to use one of two algorithms to determine which patients are active:

• Those with the Active patient checkbox checked.
• Or those with at least one unresolved problem.  

You can double-click on any item to open the patient’s chart.

Donation report
This report tabulates donation information. You will be prompted to choose a date range 
and a folder to save the report to.  The report totals donations made via cash, check 
and credit card.

Recent special entries
This report will display all special entries made in the last X days where X is a 
configurable number of days.  Special entries are entries made in an animal’s chart or in 
an Enclosure log when the Entry type is something other than Normal entry (i.e. Vet 
entry, important event). This report contains a list for individual animal special entries 
and one for Enclosure log special entries. Double-clicking on one of the special entries 
will open the corresponding animal’s or enclosure log chart.

Entries that need review
If enabled on your system, this report will display all entries that need review before 
being finalized.  Entries that need review may be present in an animal’s chart or in an 
Enclosure log. Because of this, this report contains a list for individual animal entries 
and one for Enclosure log entries. Double-clicking on one of the entries will open the 
corresponding animal’s or enclosure log chart.  The record can be edited and the entry 
type should be changed to one of the other options such as Normal or Vet entry.   If 
configured on your system, there may be a text template setup (blue arrow) that you 
can use to auto-insert a text statement stating that this record was reviewed. This 
template can include a [TIMESTAMP] macro (red arrow) that will auto-expand to the 
current date and time.

After you have reviewed and saved some entries, you can then press the Rerun report 
button to refresh the screen to reflect your changes.
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Collection value report
This report will generate an itemized list of all animals that are currently in the resident 
animal collection.  The total value for each species and the total value for the entire 
collection will be calculated.  Only resident animals are included. Animals in rehab are 
ignored. The value for each individual is taken from the Value specified for each species 
in the Species Editor.  However, as individuals of a particular species may have 
different values, the value of any individual can be overridden by creating an Value 
attribute and specifying the value in 
the local currency.  For example, a 
species may have a typical value of 
$50.00 but an unusual individual 
happens to have a value of $250 due 
to some interesting color or genetics. 
In this case, you can add an animal 
attribute with the Name=Value and the 
Value=250. See Attributes for more 
information.

Enclosure Cleaning and Maintenance
This report displays when each enclosure was last cleaned, disinfected and when the 
water was last changed. It can be used to schedule the next cleaning and to prioritize 
which enclosure should be cleaned next.  For installations that use curators, the list can 
be filtered by a specific curator.  If an enclosure contains only one animal, then that 
animal’s name will be displayed next to the enclosure name.
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The Year-End Reports
Choose Reports ▶ Year-end reports from the main 
menu to generate your year-end state and federal 
reports.  You can select either this year or last year 
as well as the report you would like to run.  The 
following options apply to all reports:
• Include only avian species - the report will 

include only avian species. Otherwise all types of 
animal species will be included in the report.

• Use common species names - the reports will 
use the common name instead of the species 
abbreviation.

In addition, there are state-specific options that you can select.  Once you choose the 
reports to generate, press the Ok button. You will then be prompted for a folder to save 
the reports to. The reports are created in an html format so you can view them in a web 
browser by double-clicking on them. You can also send them as an attachment to an 
email.

The following reports are currently supported:
• US FWS rehabilitation
• US FWS eagle exhibition
• US FWS education/possession

• AZ state rehabilitation report
• IL DNR state rehabilitation report
• IL endangered/threatened program usage report
• NC state rehabilitation report
• NC state education report
• PA state amphibian/reptile education report
• SC DNR state rehabilitation report
• TX state education report
• WA DFW state rehabilitation report
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Monthly Report
This report displays the number of each 
species admitted on a  monthly basis and it 
compares/displays the corresponding values 
from the two previous years.  You can select 
the year and month and you can also choose 
All for the month to see numbers for the 
entire year.

This report can be printed or saved as an 
html file.

The Historical Patient Count Report
This report displays a graph of the total 
patient population (animals in rehab and 
permanent residents) over time.  You can 
choose the time duration over which to display the data and you can see a tally of the 
total patient-days per year for the last 5 years by pressing the Patient day counts link.  
This report is very useful when forecasting as it clearly shows monthly and yearly trends 
regarding your patient population.

Rehab Trends
This report tabulates and graphs various statistics over time.  The following statistics are 
calculated:
• Release rate (2 different ways)
• Releasability rate
• Euthanasia rate
• E24 rate
• Death rate
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• D24 rate
• Days in rehab

The formulas used to calculate the various statistics are displayed in the upper right 
corner and the actual data is displayed in a table in the upper left.  You can choose the 
Start year as well as which statistics to graph.  In addition, you can choose an Interval 
of either one month or six months. This Interval is used to determine how many data 
points are calculated to create a graph.

Species disposition report
This report totals the individuals for each species admitted within a specified date range 
by their current disposition/status.

Program usage report
This report totals all program usage for a specified year. Only animals with Program 
animal checkbox checked are included on this report.

The Band Report Report
This report will produce a spreadsheet that summarizes each band report.  It includes 
information about the patient as well as the time elapsed and distance traveled between 
the initial release and the subsequent report.  You can sort the spreadsheet by clicking 
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on each column and you can export the data to the clipboard to paste into another 
program like Excel by clicking the Copy data to clipboard link.

You can also export the reports to a Google Map by pressing the Export to Google 
map link.  A new map will open that shows each report connected by a line to the 
preceding release.  You can click on each balloon to get details about each report.

Patient Table Viewer
This report lists all patients in a tabular format.  You can select which year to view and 
then sort the entries by clicking on any column heading.
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Sample Viewer
This report lists samples that have been collected. Click here for more information on 
samples.  You can display samples whose results are still Pending or all samples by 
making a choice from the Which list.  You can also enter a specific Patient id to view 
samples for just that patient.  Double-click on any entry to open the patient’s complete 
chart.  Note: sample test results are considered Pending if the test results field is blank.

Client-owned animal report
This report shows important information for all your client-owned animals. You can view 
all new admissions between a date range or you can view all “active” patients.

Miscellaneous reports

Patients not fed or treated today
This report lists all patients (in rehab or permanent resident) that have not had an 
entry made in their chart today.  It is a good idea to run this report at the end of 
each day to catch any patients that may have been accidentally forgotten.

Patients not fed or treated yesterday
This report lists all patients (in rehab or permanent resident) that did not have an 
entry made in their chart yesterday.  

View last record entries
This report lists the last entry made today for each patient.  You can select either 
Rehab or Permanent resident and either Diurnal or Nocturnal.   This report is 
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useful as an end-of-day check to make sure each patient has received the proper 
treatment or food.

Patients that need live prey test
This report lists all patients in rehab that have their Needs live prey test 
checkbox checked. Click here for more information.

Ophtho consult waiting list
This report lists all patients (in rehab or permanent resident) that have their 
Needs ophtho consult checkbox checked. Click here for more information.

Falconer evaluation waiting list
This report lists all patients in rehab that have their Needs falconer eval 
checkbox checked. Click here for more information.

Patients that need placement
This report lists all patients in rehab that have their NR checkbox checked and 
their Has placement checkbox not checked. Click here for more information.

Missing release locations
This report lists all patients that have been released but for which an actual 
latitude and longitude have not been recorded in their Release record.  Click 
here for more information.  This report is helpful for birds that have been released 
with a federal band because the release location must be recorded and 
submitted with your banding reports.

Imp report
This report lists all patients (in rehab or permanent resident) that have their 
Needs imp checkbox checked. Click here for more information.

Cope report
This report lists all patients (in rehab or permanent resident) that have their 
Needs cope checkbox checked. Click here for more information.

Cold-intolerant patients
This report lists all patients (in rehab or permanent resident) that have their Cold 
intolerant checkbox checked. Click here for more information.

Orphans ready for transfer
This report lists all patients in rehab that have their Neonate/orphan checkbox 
checked and their Release approved checkbox checked and they have an 
expected release date set.  Click here for more information on the checkboxes 
and here for information on setting the Expected Release Date.  Basically, this 
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lists all orphans that are ready to transfer to another facility to finish the rehab 
process.

Waiting for consult
This report lists all patients (in rehab or permanent resident) that have a 
specialist consult scheduled in their individual treatment plan. Click here for more 
information.

Patients in hospital
This report lists all patients (in rehab or permanent resident) that were in the 
clinic on a specific date. You will be prompted for a specific date before the report 
runs.

Patients > 90 days and patients > 180 days
These report lists all patients that have been in rehab over 90 or 180 days.  You 
can sort the report by clicking on each column.  You can have the report show all 
patients that are within one month of the number of days (90 or 180)  by selecting 
the Show patients within 1 month... checkbox. This allows you to request a 
rehab extension ahead of time.  

To automatically create an email listing details of all patients currently displayed, 
press the Send report email link.  This will create an email that you can edit if 
needed and send to the appropriate authorities.  Each patient reported in the 
email will automatically be marked as “reported” by the addition of a special 
“already reported” patient attribute. 

In addition, you can choose to see only those patients that have not been 
reported yet by checking the Only show unreported patients checkbox.
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Admissions
This report displays the number of admissions with a user-specified date range. 
The report is broken down by species and both the common and scientific name 
are displayed.

Endangered species
This report displays all endangered species that were admitted within a specific 
year. Only animals with a status of Endangered specified in the Species Editor 
will be included.

No leftovers
This report displays all animals that have not had leftovers for the last X days 
where X is a configurable number.  This report requires that the Leftovers field in 
the Medical Entry form be used and it is useful in finding animals that may need 
to have their diet increased.

Volunteer training
If enabled, his report displays the volunteer training records for volunteers. See 
the Address Book for more information.

Client-specific reports
This area in the Reports menu contains reports that were specifically designed and 
implemented for a specific client and/or state  Some may or may not be available in 
your installation.
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Census reports
Annual census report
Aquarist habitat census report
Exhibit census report
Habitat census report
Habitat census report with id tag/band information

Chemotherapeutic exposure report
HMS interim report - Highly migratory species monthly report
HMS annual report - Highly migratory species annual report
Create float plan
Create scientific collection notification
Create transfer agreement
Email active patient list
Print curator summary
Collection site report - This report will lookup where specific species where 
collected.  This uses the Collection site name as a key. If exact lat/lon 
coordinates where also saved, then the collections can be plotted on a Google 
map.

North Carolina permit reports
Sea turtle census report
Reptile/amphibian possession report
Reptile possession report
Amphibian possession report
Freshwater collection report
Collection report
Endangered species report
SECP report - The North Carolina Scientific or Educational Collection 
Reporting Form report includes all collections of salt-water species for a 
given year.

!
California permit reports
! Department of Fish and Wildlife Rehabilitation report

Outstanding disposition letters report
This report will list all animals that were admitted and had an answer of YES for 
the fourth admission question. This question typically asks if the finder would like 
to be notified about this animal’s progress.  This list will display information about 
the animal including its current status and the number of days since admission.  
You can select any or all of the animals in the list, then press the Send email 
button. An email will be automatically formatted and addressed. You can review, 
edit and send each one as desired. Note: the animal must have an email address 
for the finder or person of concern listed in its medical record for an email to be 
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generated. If no email is found, an error message will be displayed. Once the 
email is sent, the Disposition letter sent checkbox is checked in the animal’s 
chart. This checkbox makes sure that it will not show up in this report the next 
time you run it.

You can also press the Mark as sent button. This will simply check the 
Disposition letter sent checkbox in the animal’s chart without actually sending 
the email. This is useful, if the person in question has already been update via 
some other means.

OWCN report
This report is used to bill the OWCN network for costs incurred when treating 
oiled birds.  The user is prompted for a date range. All animals within that range 
will be included if they showed visible signs of oiling on their intake examination.  
The intake examination will normally result in the following text entered into the 
medical record:

------------- PHYSICAL EXAM FINDINGS ----------------
Oiling signs : Visible 
% oiled : 2-25 % 

This report will include all animals that have Visible recorded for Oiling signs. 
The notification date column is filled with the value stored in the animals OWCN 
notification date attribute.  The Daily cost  (in water less than 75%) is based on 
the species Cost category. The Daily cost (in water greater than 75%) is 50% 
of the dry cost.

Snake log
The snake log report list all resident animal snakes.  It searches the medical 
record for keywords and the goal is to highlight those snakes that have been fed 
but have not produced feces.  You can filter your search by animal’s name and/or 
look at a specified number of months into the past.  The report will list the 
animals id number and name as well as each relevant entry.  The entries that it 
looks for are of the following format:

SNAKE LOG: Fed ...
SNAKE LOG: Excrement ...

Animals will be highlighted that have a Fed entry but do not have an Excrement 
entry afterwards.  You can double-click on an animal’s id to open it’s chart.
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Sun log
The sun log report list all resident animal that have been specified as needing 
regular sun exposure.  To include an animal on this list, it must have an Include 
in sun log attribute set. See Attributes for more details. For each animal on 
the list, this report searches the medical record for certain keywords and it 
highlights the animals that have not had sun exposure in the last X days.  You 
can filter your search by animal’s name and/or look back a certain number of 
days into the past.  The report will list the animals id number and name as well as 
each relevant entry.  The entries that it looks for are of the following format:

SUN LOG: 2 hours on the patio
...

Animals will be highlighted if a SUN LOG entry was not found in the specified 
number of days.  You can double-click on an animal’s id to open it’s chart.
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Illinois endangered/threatened species permit report.
This report is used to transfer or dispose of a deceased endangered or 
threatened species. It will prompt you for a transfer or disposal. If transferring, 
you will be prompted to choose a destination contact from the Address Book. If 
disposing of a body, it will prompt you for a short explanation.

PAWS vet procedures report
Texas education permit report
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Chapter 5
Group operations
Advanced search tool
Query tool
Address book
Event planner
Cost estimator
Document repository
Handler training log
Transporter text messages
Inventory manager
Program log
Client manager
Surplus/wishlist manager
Spill manager
Program scheduler
Custom automated alerts
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Group operations
The group operations allow you to perform various functions on a whole group of 
patients at the same time.  They are accessed by choosing Tools ▶ Group operations 
from the main menu or by right-clicking on a specific location in the Enclosure list on 
the main screen and choosing Group Operations from the popup menu.  A form will 
appear that allows you to enter and select the id numbers of the patients you want to 
work with.  

If you access the group operation functions by right-clicking on an enclosure, then the 
list of patients will be automatically filled with all the patients in that enclosure.  If you 
access the group operations from the main menu, then you can enter specific id’s for 
the animals you want to work with.  In either case, check the boxes in the first column 
for the rows of the animals that you want to modify.  Press the Select all link to 
automatically select all animals in the list.  There are fields to enter the date and time for 
the operation. They default to today and now but you can back date them to record 
something that happened in the past.

Groups of animals can be moved, released, transferred or added.  In addition, you can 
change the various properties of multiple animals in a group. You can also add 
enrichment and training records, program usage logs, problems, photographs and fecal 
exam results for groups of animals.  Finally, you can also make a random entry for all or 
some animals in a group.

Move
After making your selection in the patient list and entering your initials, choose the new 
location to move the patients to and press the Ok button.

95



Release
After making your selection in the patient list and entering your initials, press the Ok 
button.  The Release form will be displayed.  Fill it out accordingly and press the Ok 
button.   Note that this form is simplified and does not include the band/tag fields since 
you cannot specify a band or tag for multiple animals at once.

Transfer
After making your selection in the patient list and entering your initials, press the Ok 
button.  The standard Transfer form will be displayed.  Fill it out accordingly and press 
the Ok button.

Set patient info
This function allows you to simultaneously set/modify several different properties for 
multiple animals in a specific location.  The following properties can be set:
• Band/tag
• AgeIn - choose from the list that will appear when you click in cell
• Age - choose from the list that will appear when you click in cell
• Sex - choose from the list that will appear when you click in cell
• Status - choose from the list that will appear when you click in cell
• Final date - enter in yyyy-mm-dd format.  Note that this field must be filled in with a 

valid date if you choose a Status that requires a Final date.
• Release approved - check the box for if applicaable
• Expected release date - enter in yyyy-mm-dd format
• Neonate - check the box for if applicable
• Keywords - anything entered here will be appended to the patient’s current list of 

keywords.

Note: in order to modify a patient, you must place check the box in the first column. To 
leave a patient unchanged, clear the check box.  Also note that the Patient id and 
Species columns are for informational purposes only. They cannot be modified here.

You can right-click on a cell and choose Fill down to copy the cell’s value to all cells 
below it.

After making your selection in the patient list, press the Ok button.
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Add
The Group Add function is slightly different than the other group operations since a list 
of animals is not presented.  In this case, you must specify how many animals you want 
to add and where they are going to be 
located.  You can also specify a band/
tag number if each animal is to be 
identified the same way.  

There are the following check boxes:
• Neonate/orphans - if this is checked, 

then Neonate/orphan checkbox in the 
animal’s chart will be automatically 
checked and the specified values for 
the age, cause of injury and initial 
problems will be automatically set for 
you.

• Oiled - if this is checked, then Oiled 
will be added as a problem.

• Group as one - if this is checked, 
then a single GROUP animal will be 
added.  See Update Census command 
for more information.

Once you do this, the normal Add patient form is presented.  After filling out that form, 
the specified number of new patients will be created with sequential id numbers and 
they will automatically be placed in the specified location. Any number of animals can be 
added but you will be prompted to confirm the operation if you enter a number larger 
than 10.
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Note that you still have to setup a treatment plan for these new patients.

Enrichment
After making your selection in the patient list and entering your initials, press the Ok 
button.  The standard Enrichment form will be displayed.  Fill it out accordingly and 
press the Ok button.

Training
After making your selection in the patient list and entering your initials, press the Ok 
button.  The standard Training form will be displayed.  Fill it out accordingly and press 
the Ok button.

Program log usage
Only animals with the Program animal  checkbox checked will be listed. If you choose 
this function from the main menu, then all program animals will be listed.  After making 
your selection in the patient list and entering your initials, press the Ok button.  The 
standard Program Log form will be displayed.  Fill it out accordingly and press the Ok 
button.  

When you are recording a program log for more than one animal, you will be prompted 
as to whether you want to split the number of people present at the program between all 
the animals evenly or use the entire number for the log entry for each animal. For 
example, if 4 animals went to program with 100 people, you have the option of 
recording 100 people in each animal’s log entry or just 25. It really depends on how you 
do your record keeping and how your reports need to reflect the number of people 
present.

Problems
Making your selection in the patient list.  Select one or more problems from the problem 
list and the press the Ok button. 
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Photograph
Make your selection in the patient list.  Then drag and drop an image/photograph onto 
the image viewer area.  A popup will allow you to crop and resize the image.  You can 
make a notation and the press the Ok button.

Fecal
After making your selection in the patient list and entering your initials, press the Ok 
button.  The standard Fecal form will be displayed.  Fill it out accordingly and press the 
Ok button.
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Weight range
Often individuals in groups of animals cannot be uniquely identified. In this case, the 
lowest and highest weight in the group can be recorded and graphed. This allows you to 
spot trends without actually knowing individual weights. 

After making your selection in the animal list and entering your initials, enter a high and 
a low weight entry.  Press the Ok button. This will make a weight range entry in the 
chart for each of the selected animals. The group weight range data can then be view in 
the Historical Data Viewer.

Automated paperwork
RaptorMed can automate much of the routine paperwork that is required by the US 
FWS. To access these functions, right click on the patient in the Patient List on the 
main window and choose Paperwork.  The following functions are automated:

• Send Special Species Admitted email - The USFWS must be notified when any of 
the species of interest (such as eagles) are admitted into a rehabilitation facility.  This 
function automates the process.  A form will be displayed with an email message pre-
written to contain the specific information about the patient of interest. The email is 
pre-addressed to your USFWS representative and is based on a template that you 
can edit to suit your needs.  You can edit the message if needed and press the Send 
button to send the message.  These messages are only sent for animals in a 
rehabilitation setting, not for animals that are permanent residents in a  collection. In 
addition, these messages are only sent for species that are marked as a species of 
concern either at the state or federal level.  See the Species editor for more 
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information.  When a special species is admitted as a rehabilitation patient, a daily 
repeating reminder is created in order to remind you to report this admission.

 
• Send Illegal Cause of Injury email - The USFWS must be notified when a patient is 

admitted as a result of illegal activity such as gunshot.  This function automates the 
process.  A form will be displayed with an email message pre-written to contain the 
specific information about the patient of interest.  The email is pre-addressed to your 
US FWS representative and is based on a template that you can edit to suit your 
needs.  You can edit the message if needed and press the Send button to send the 
message.  The list of causes of injury that should be considered illegal can be 
configured as needed. These messages are only sent for animals in a rehabilitation 
setting, not for animals that are residents in a permanent collection. When an animal 
with an illegal cause of injury is admitted as a rehabilitation patient, an daily repeating 
reminder is created in order to remind you to report this admission.

• Send Status email - This function allows you to quickly send a patient status update 
email.  A form will be displayed with an email message pre-written to contain the 
specific information about the patient of interest.  The email is pre-addressed to the 
address specified in the patient’s finder information.  If no address was specified, then 
you can manually enter an address.  You can edit the message if needed and press 
the Send button to send the message.

• Send other emails produces a form that allows the user to choose which of many 
pre-formatted emails.  Choose from the Function list.  The To, Subject and message 
body fields will be filled in. Edit as needed and press the Send button to send the 
message.

• Create Transfer Request - An official USFWS Transfer Request worksheet must 
usually be submitted before a non-releasable animal can be transferred.  This function 
creates a worksheet for you based on a pre-installed template.  You will be prompted 
for a folder where the new worksheet will be saved.  Once it is saved, you can double-
click on it to open and edit it before submitting it to your USFWS agent.

• Write Non-Releasability Letter - A letter of non-releasability from a veterinarian is 
often required before a non-releasable animal can be transferred. This letter is 
typically addressed to the recipient from the veterinarian representing the organization 
transferring the animal.  This function creates a new letter for you based on a pre-
installed template with the patient’s information plugged into it.  You will be prompted 
to choose an recipient from the Address Book.  You can choose an existing entry 
from the Address Book.  If the recipient is not in the Address Book, then press the 
Cancel button and the recipient area in the letter will be left blank for you to manually 
edit.  You will then be prompted for a folder where the new letter will be saved.  Once it 
is saved, you can double-click on it to open and edit it before sending it to the 
recipient. 
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• Report Band - This function simply opens a web browser to the USGS Bird Banding 

Lab Band Report web page. 

• Print admission receipt - This function will print a receipt for the person delivering 
the animal.  It has details about the animal as well as any donation that may have 
been given. 

• Link to previous patient - This function is used to record a band report (when a new 
patient is admitted that was previously released with a band or tag).  After the new 
patient is entered and it’s found location has been recorded (ideally including the exact 
latitude and longitude), choose this command. The database will be searched for a 
previous patient with the same band or tag. If one is found, the following will occur:

• A band report record will be created based on the found location of the new patient 
and it will be attached to the previous patient.

• The previous patient will be marked as a BAND_RETURN.
• A notation will be added to the new patient indicating the id number of the previous 

patient.

These functions should have been configured and tested when the system was 
installed. Please contact customer support if you encounter any problems. 

Searches and queries
Advanced Search Tool
This tool allows you to search for and find past patients based on a whole range of 
parameters.  It is accessed by choosing Tools ▶ Advanced search tool from the main 
menu. You can specify many different parameters to narrow your search.  Once you 
have specified your search criteria, press the Search button.  The results will be 
displayed in the spreadsheet and the number of patients found will also be displayed.
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The following fields do NOT have to be an exact match: Finder name, Organization, 
Keyword, and Problem.   The results will be sorted by Patient id unless you specify a 
different column name in the Sort by field.  You can copy the results to the clipboard to 
use in another program by clicking the Copy results to clipboard link.

Image Search Tool
This tool allows you to find images 
based on various attributes of the 
animal as well as the 
type of image and the 
image description. It is 
accessed by choosing 
Tools ▶ Image 
search from the main 
menu. You can specify 
many different parameters to 
narrow your search.  Once you 
have specified your search 
criteria, press the Search button.  
The results will be displayed in the 
spreadsheet and the number of 
images found will also be 
displayed.  You can double-click 
on any entry to view the animal’s 
chart or SHIFT left-click to view 
the actual image.

Double-click on an entry to 
open the patient’s full chart.

IMAGES FOUND HERE
Double-click to open the 
animal’s chart. SHIFT 
double-click to view the 
image.

Image attributes 
like Type and 
Description.

Animal attributes 
like species, 
admission date, 
etc.
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You can copy the results to the clipboard to use in another program by clicking the 
Copy results to clipboard link.

Band lookup
This tool is accessed by choosing Tools ▶ Lookup band/tag from the main menu. It 
allows you to find an animal based on the information in it’s band/tag field.

Lookup by legacy id or group number
This tool is accessed by choosing Tools ▶ Lookup by legacy id or group from the 
main menu. It allows you to find an animal based on the id number that it had in the 
original database prior to being imported into RaptorMed.  This information is stored as 
a patient attribute but the actual name of the attribute depends on the customer and the 
previous database.

The Query Tool
The query tool is a very powerful utility that allows you to pose very complex queries to 
the database.  It allows you to mine your data in ways never before possible and it can 
create beautiful graphs with just a few mouse clicks. This tool is accessed by choosing 
Tools ▶ Query tool from the main menu.  Here are some example queries: 

• Show me all red-tailed hawks that 
were admitted in 2010 from Gaston 
county, NC with an ulna fracture.

• What are the admission trends in bald 
eagles since 1980?

• What was the outcome of all patients 
treated with experimental drug X?

• How has our surgical time for 
humerus fracture repairs improved 
over time?

Queries of this type require in-depth 
knowledge of the internal database 
structure.  Because of this, you will 
likely need assistance from customer 
support.  So, send us a question you 
would like answered and we will create a custom query.  This is simple file that you can 
drag and drop onto this form.

You can also type or paste the query text into the edit field at the top of the form.  After 
you press the Run button, your results will display in the Results spreadsheet at the 
bottom.  You results can be copied to the clipboard and then pasted in Excel or any 
other Windows application. To copy the results to the clipboard, Edit ▶ Copy results to 
clipboard from the menu.

Type or paste a 
query here. Or 
drag and drop a 
query file here.

The results are 
displayed here.
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Queries can also be saved for 
later recall.  Under the File 
menu, there are choices to 
Open, Save, and Save as.  You  
can also Delete or Rename the 
currently loaded query by using 
the corresponding commands 
under the Edit menu.

Your data can be graphed using 
the Graph Wizard.  Once you 
have run your query and  have 
your results listed in the Results 
spreadsheet, press the Graph 
button and the Graph Wizard 
will appear.  The wizard has 
three tabs that allow you to 
modify the appearance of the 
chart.

Tab 1 allows you to specify:
• The title
• The text labels for each axis
• The starting value and 

increment value for each axis. The increment value determines how far apart the 
horizontal and vertical lines are spread.

• The number of points to include in your graph. If you dataset has 50 points, you can 
choose to graph just the first 25, for example.

Tab 2 allows you to change: 
• the graph type (line, bar, scatter, pie)
• The line and bar thickness for line and bar graphs, respectively.
• The symbol shape (square, x, circle, cross or no symbol) and size for line and scatter 

graphs.
• You can also specify whether to fill the area under the curve for line graphs.

Tab 3 allows you to specify the various colors. Double-clicking on each square in the 
color palette. If you hover your mouse over each square, a tool tip will appear that tells 
you what the color is for.

After making your selections and changes to colors, etc, press the Redraw graph 
button to see what your chart looks like.  Once you are happy with its appearance, 
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press the Copy to clipboard button to save the chart to the Windows clipboard. You 
can then paste it into another document like Word or Powerpoint.

If you have color scheme that you like you can save and recall it for later use. You can 
select a color scheme by choosing it in the color scheme list.  If you make changes, you 
can save them by pressing the Save link or save them into a new color scheme by 
pressing the Save as link. You can remove the currently selected color scheme by 
pressing the Remove link.

The Address Book
The address book allows you to store contact information for all sorts of things like 
people, places, suppliers, etc.  To access the Address Book, choose Edit ▶ Address 
Book from the main menu.

The Address Book viewer lists each contact.  You can sort by any of the columns and 
you can filter the list to show only certain types of contacts by choosing from the Type 
list at the top. You can add a new contact by pressing the + button or remove the 

Note: in order to use the Graph Wizard, the query must be 
formulated such that the values for the X axis are in the first 
column and the values for the Y axis are in the second 
column.  If you data is not presented in the correct order, you 
can modify the query to fix it or press Swap axes on the first 
tab.

Data obscured for 
privacy.

Data 
obscured 

for 
privacy.
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selected one by pressing the - button.  You can 
edit the selected contact by double-clicking on 
it.

The contact editor has 4 tabs.

• Tab 1 - Basic info - This tab has fields for:
• Contact information including multiple 

phone numbers. 
• Check boxes to choose which type of 

contact this is. The following contact types 
are possible.  Note that more than one 
type can be selected, so a contact/entry 
could be a rehabber and a transporter, for 
example.

• Transporter - For people that can 
assist with rescuing and transporting 
injured animals.

• Animal control - Animal control agencies. Usually government/county-run, but 
not always.

• Rehabber - Other rehabilitation facilities or people that you work with.
• Falconer - Falconers.  Sometimes useful for rehab or for rescuing birds 

trapped in warehouses.
• Volunteer - Volunteers of your organization.
• Government agency - USFWS, state DNR, etc.
• Supplier - Suppliers for medications, food, etc.
• Handler/trainer - People in your organization that handle/train resident 

animals.  Only contacts with the check box checked will be included in the 
Handler training log.

• Educator/museum - Educational facilities that you work with. Useful when you 
need to place non-releasable animals.

• Zoo/aviary 
• Staff - Staff members at your organization.
• Veterinarian - Veterinarians that you work with.
• Site/nature preserve - Actual locations that you use, potentially for release 

sites.  The Release form allows you to choose one of these entries so that the 
location information does not have to be re-entered.

• Inactive - Used to mark this contact as inactive. This allows you to keep the 
contact information in the Address Book without having to delete it completely.
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• Tab 2 - More info - This tab has several miscellaneous fields for:
• A web address
• Date of birth - Note: this field is only viewable by RaptorMed users who have 

Administrator privileges.
• Permit information
• A field that allows you to record if a 

certain contact is looking for specific 
non-releasable animals.  If you enter 
something here, this contact will be 
listed when you choose Looking for 
animals from the filter in the 
Address Book list window shown 
above.

• The Availability field allows you to 
record when, for example, a 
Transporter-type person is available 
to go out and rescue an animal. For 
example, you might enter something 
like “M-F PM + weekends” or “Any 
day except Tuesday”.

• Latitude and longitude - these 
must be filled in if you would like to 
plot this entry on a Google Map (see 
below).

• Note that the Cell provider is only 
needed if you intend to use the Text Messaging function.

• Permit numbers
• The Notes fields is for any additional information that you would like to record for 

this contact.
• The check boxes for AM/PM and  Sun-Sat are used determine when it is 

appropriate to send a Transporter-type person a text message.  Click here for 
more information.

• Tab 3 - Photo - This tab allows you to import an image for this contact. It could be 
photo of a volunteer or a scan of a business card for a client or supplier.  You simply 
drag and drop and image into the designated area.  A window will popup that allows 
you to resize, crop and flip the image. When you have adjusted it the way you like, 
press the Ok button.

• Tab 4 - Training - If enabled, this tab allows you to record when a staff member or 
volunteer has been signed off on a certain training item. There will be a list of pre-
defined training options. Double-click to set the date from a popup calendar.  To clear 
a date, right click and choose Clear date.  The training data for volunteers is tabulated 
in the Volunteer training report.

Click here to 
pull the lat/lon 

from the 
RaptorMed
Google Map.

For configuring  
the text message 

function.
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The Copy to clipboard link allows you to quickly copy an Address Book entry’s contact 
information to the clipboard.

Exporting to a Google Map

The entries in your Address Book can be 
exported to a Google Map by choosing Report 
▶ Export address book to Google map from 
the main menu.  A window will appear that 
allows you to choose the types of Address 
Book entries you want to export.  Remember 
that only entries with a valid latitude and 
longitude can be exported.

Once you make your selections and press the 
Ok button, you will be prompted for a folder to 
save the Google Map to.  An html file will be 
created. You can then double-click on it to view it 
in your browser.  Each entry will have a color-
keyed balloon and you can click on each balloon 
to get information about the entry.

It is very recommended that you export 
Transporters, Rehabbers and Animal 
control agencies to the map.  If you do 
this, this map will be very helpful when 
trying arrange for the capture and care 
of an injured animal.

This map is also very useful as it will 
store the latitude and longitude in the 
Windows clipboard when you double-
click on a point.  Note that this feature 
does not work with Internet Explorer but 
works well with Google Chrome. When 
you double-click a point, a popup will be 
displayed. Press CTL-C and then the 
OK button. This will copy the 
coordinates to the clipboard.

This location can then be automatically 
imported by RaptorMed and is helpful 
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when:
• Recording where an animal was found or collected
• Recording a Release
• Sending a text message to transport volunteers
• Recording Band Reports
• Creating new Address Book entries
• Creating an Oil spill log entry.

The Event Planner
The Event Planner is accessed from the main menu under Tools ▶ Event planner.  
This tool is great for fundraising as it helps coordinate events where you are planning to 
release an animal.  This tool allows you to create and schedule events and match those 
events with animals that have upcoming expected release dates.  The Event Planner 
lists all events at the top and all animals with an Expected release date that has been 
set are listed at the bottom.  Remember, the Expected release date is only a best 
guess as last minute changes or delays are not uncommon.  Click here for information 
on setting this date.

To use the tool, there are three steps that need to be followed:

1. Create an event.
2. Mark animals with an upcoming release dates.  This is done in the Patient Info form.
3. Match an animal to an event.
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You can view All events or all 
Upcoming events by selecting 
from the When list.  The 
highlighted events are those that 
were marked with highest 
priority.

The Patient list displays the 
patient’s expected release date, 
id, species and age. The RWF 
column refers to Release 
Where Found and indicates 
that this patient was requested 
to be released at the site where 
found so it may not be available 
to use in a special event (click 
here for more information).  The 
Approved column indicates 
whether this patient has been 
approved for release yet.

When an animal is associated with an event, the event’s 
description will be displayed in the patient’s Release 
event field.  

To create a new event, press the + button.  To delete the 
selected event, press the - button.  Double-click an event 
to edit it.

To add or edit an event, a form appears that allows you to 
enter a Description for the event, who is the main contact 
person and where the event is to take place. The Date is 
optional as some events may be flexible and may be dependent on the availability of a 
certain species to release.  The Site approved check box is used to indicate that the 
specified location has been reviewed and approved.  The Priority can be set and High 
priority events will be highlighted in the Event list.  There is an additional Notes field 
and the desired Species can also be specified.

Event list

Patient list

Drag & drop 
with shift key 

pressed

Note: RAR refers to 
Release-A-Raptor which 
is catchy name for the 
release program 
developed at the Carolina 
Raptor Center.  Its 
meaning has been 
expanded to include the 
release of any type of 
animal.
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The First choice and Backup fields indicate 
which animal(s) are matched with this event. You 
can simply enter the patient id of the desired 
animal(s) in the appropriate fields or, with the 
Shift key pressed, drag and drop a choice from 
the Patient list to the Event list.  Be sure to drop 
the choice in either the Primary or one of the 
two Backup columns for the desired event in the 
Event list.

Cost Estimator
The Cost Estimator function is 
a tool that provides an estimate 
of the cost associated with the 
treatment for a specific patient.   
It is accessed by pressing the 
Cost estimator link in the 
Action Bar on the patient’s 
chart.  

The estimator automatically 
tallies the number of days in 
rehab, as well as radiographs, 
bloodwork and many other 
tests and procedures.  

Although usually unnecessary, 
you can edit each line item if 
necessary to change a 
description, quantity or cost.  
There are also blank lines at the end that can be used to add completely new items.  

The cost estimator report 
is very useful to show to 
the public at release 
events. It provides a 
detailed list of everything 
you did for that animal. 
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Once the spreadsheet accurately reflects the desired costs, press the Calc total button 
to have the total calculated.  Note that any edits you make here will NOT be saved.

Press the Print button to create a report that summarizes the animal’s basic 
information, problems, all treatments and costs.

The Document Repository
This function is accessed by selecting Tools ▶ Document repository from the main 
menu.  The repository provides an easy-to-access location for various documents and 
files of any type.  Rather than storing them 
in various folders on different computers, 
they are all stored in one place, and can be 
accessed from any computer that has 
RaptorMed installed.  In addition, these 
files will be automatically 
copied for safe-keeping when 
the rest of the database is 
backed up.

To add a file to the repository, 
simply drag and drop it onto 
the form. Or you can press the 
+ button and browse to select the 
file when prompted.  You will be prompted 
for a description of the file and it will then be 
added to the list.  To view or edit a file 
already in the repository, just double-click on it.  To delete a file, select it and press the - 
button.

You can create folders to organize your documents by pressing the Add folder link. To 
enter a folder, double-click on it. To back out of a folder, double-click on the  entry that 
will be listed at the top of the list.

Handler training log
RaptorMed can help you keep track of who is trained to work with various animals in 
your resident population.  To access this function, choose Edit ▶ Handler training log 
from the main menu.  

For each resident animal, you can specify a Training level.  This level indicates how 
much training a person needs to have in order to be certified or signed off to work 
independently with the animal.  The Training level can be one of the following: 

Drag and drop 
your files here

Add folder

113



Beginner, Intermediate, Advanced, or Master.  Click here for more information on 
setting the Training level.

The system can be configured so that a person needs a set number of check-offs in any 
number of training categories. Once a person has completed the required number of 
check-offs in each category, you can mark the person as certified on a particular 
animal.

In the Handler training log, you can select the Handler and the animal they are training 
on.  Only people from the Address Book with the Handler check box checked will be 
included in the list.  Only animals with a Training level set will be included the list.  Click 
here for more information on the Training level.

When an animal is selected, the Training level and the 
number of required check-offs will be displayed.  When a 
person is then selected, each training check-off will be 
displayed.  To add a new training entry for this person/
animal, press the Add entry button.  A small window will 
appear that allows you to specify the date, the initials of the 
trainer and training category.  Press Add to add a new entry.  
You can add multiple entries and then press Done when you 
are finished.

When all training is complete, add one more entry by 

The animals training level.
How many check-offs 
are needed?

Each training record is 
displayed here with the 
initials of the trainer.

The categories are 
configurable and there can 
be any number of them.
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choosing Certified for the category.  The display will change to show a green banner 
indicating that the person is now certified on this animal.

There are two reports that you can run:
• The Animal summary report lists all the Certified people for each animal.
• The Handler summary report lists the training history of each person for each 

animal.

Transporter text messages
The function allows you to quickly and automatically send a text message to all 
Transporter people in the Address Book which are within a specified radius of an 
injured animal. To access this function, choose Tools ▶ Contact transporters from the 
main menu.

To use this function:
1. Find the location of the injured animal on the Transporter Google Map.  Click 

here for information on creating the the map.  This will store the location of the 
injured animal in the Windows clipboard.

2. Choose Tools ▶ Contact transporters from the main menu.  The text message 
for will appear.

3. Press the globe button to copy the location you just stored from the map.
4. You can enter the city’s name. This will be inserted into the text message that will 

be sent.

The Certification entry
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5. Choose the desired Distance. This is the radius in miles that will be used to search 
for transporters.

6. Press the Count transporters in radius link to see how many people are in the 
desired radius.  You can increase or decrease the Distance as needed.  The list of 
available people will be printed out for you to view.  Note: contacts from the 
Address Book will only be listed here if:

• They have the Transporter checkbox checked.
• They are within the desired distance/radius.
• They have a Mobile phone number and Cell provider specified.
• They have the Accept text message check box checked.
• And finally, if the Availability check boxes for the time of day and day of 

week match the current time of day.  These check boxes allow you to 
prevent somebody from receiving a text message at times of day where 
they cannot accept them or do not want to be bothered.

7. When you have a reasonable list of transporters, press the Send button.  A text 
message will be sent to each person.  The message is configurable and is 
formatted when RaptorMed id installed but it generally says something like “There 
is an injured animal in CITY.  Can you help? If yes, please call...”.

Press here to copy the 
animal’s location.

Choose the radius
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You can also send a random text message to any 
contact in the Address Book.   Press the Send 
single message link and the following form will 
appear. Choose a recipient from the Send to list, 
type in your subject and the message body and 
press Ok.  Note that only the contacts with text 
messaging enabled in the Address Book will 
appear in the Send to list.

Inventory manager
To access this function, choose Tools ▶ Inventory manager from the main menu.  The 
Inventory Manage allows you to keep track of supplies and to print a reorder list.

Press the + button to add a new entry, double-click to edit an existing entry and press 
the - button to delete the selected entry.

The Inventory Manager will indicate if you are below your reorder count by highlighting 
an entry in red. It will also indicate if at least one item is expired.
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The Inventory Item editor has fields for the description, supplier and the part number. 
The choices in the Supplier list are entries in the Address Book that have the Supplier 
checkbox checked.

You can specify a desired number, the 
current number and the number at which 
you would like to re-order each item. You 
can also specify the units that these 
numbers are measure in such as tablets, 
bags, boxes, etc. 

You type in any number of expiration dates 
(each separated by a space) or you can 
double-click in the Expiration dates field 
to pull up the calendar. If you double-click 
on an existing date, the calendar will allow 
you to edit that date. If you double-click to 
the right of the dates, you can add a new 
date.

Back on the main Inventory Manager 
screen, press the Print reorder list link to 
produce a reorder list. This list will contain 
a entry for all items whose Current 
number is less than or equal to the 
Recorder number. The items are 
arranged and sorted by Supplier for easy 
re-ordering.
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Program log
The Program Log is accessible from the 
animal’s main chart window.  This feature 
is only available for animals that have the 
Resident check box checked.  The log 
window displays all the programs that this 
animal was used for, sorted by date.  It 
also displays the number of programs for 
this year and last year.

To add a new program, press the + button, 
to delete a program press the - button and 
to copy an existing entry, press the copy 
button.  You can edit/view and entry by 
double-clicking on it and you can print a 
program usage report by clicking Print 
report.

Each entry can store information about 
the event and location. If you do programs 
repeatedly at the same place, you can 
save the information in the Address Book 
and recall it easily by pressing Lookup 
from address book.

There are fields to record the number of 
people, the age ranges as well as the type 
of program.

The program usage for all animals can be 
reported using the Program usage report.
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Client manager
The client manager is used for client-owned animals. If enabled, this feature is 
accessed from the main menu by choose Tools ▶ Client Manager. A form will appear 
that allows you to enter a name, phone number, microchip number or a band number. 
Partial matches are allowed.  Note that a microchip scanner can be used in the green 
Microchip field to automatically fill in this field.

When you pressed the Search button, a list of matching clients will be displayed in a list 
on the right.  When you select a client, a list of their animal’s will be displayed in the 
lower list.  You can double-click on an animal to see it’s chart.

There are shortcut links that allow you to create a new client and/or a new animal/
patient on this screen.
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Surplus/wishlist manager
The surplus/wishlist manager allows 
you to keep track of animals that you 
want to add to your collection and 
also animals that you have a surplus 
of and wish to re-home.
This feature is accessed from the 
main menu by choose Tools ▶ 
Surplus/Wishlist Manager. The 
upper list is for surplus an animals 
and the lower is for your wishlist. 
Press the + and - buttons to add and 
remove entries from each list. 
Double-click and entry to edit it.  You 
can specify the number, size, age 
and sex as well as information 
(name, phone number) for the person 
to contact.
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Spill manager
The spill manager allows you to 
manage oil spill events. This 
feature is accessed from the 
main menu by choose Edit ▶ 
Spill log. The upper list shows 
all the spill events. Press the + 
and - buttons to add and remove 
entries from this list. Double-click 
and entry to edit it. You can 
specify when and where the spill 
event took place as well as 
information about the type and 
amount of crude that was 
involved.  The choices for the 
Type of crude can be configured 
(see Editing list choices).

If you single click 
on a spill entry, all 
the animals that 
are associated 
with the spill will 
be listed in the 
lower list. You can 
double-click on 
any of the animals 
to open the 
corresponding 
chart.

Click here to pull 
the lat/lon from 
the RaptorMed

Google Map
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Program scheduler
The Program Scheduler is used to reserve program animals for programs without 
worrying about scheduling conflicts.  To use the Program Scheduler, choose Tools ▶ 
Program scheduler from the main menu.  A window will appear that lists all the 
resident animals that have 
been designated to be 
Program animals. That 
is, they have their 
Program animal 
checkbox checked.

After you specify a date, 
the this tool will highlight 
each animal that has a 
conflict on that date. A 
conflict is either due to 
another program already  
being scheduled on that 
exact date or if a program 
is scheduled for within X 
days of the specified date.  
The actual number of 
days is configurable and 
this feature is useful in 
order to prevent an animal 
from being scheduled 
several days in a row without a day off, for example.

The animal list displays the animal’s id, name and 
species. Choose the animals that are needed for a 
specific program by checking the appropriate check 
boxes on the left-most column.    Once you have 
selected the animals that will be needed. press the 
Reserve for program link. The standard Program 
Log  form will be displayed.

At any time, you can double-click on an animal to open its chart (blue arrow). This is 
useful, for example, when resolving a conflict and you want to see what program an 
animal is already scheduled for.   Once you have opened the chart,  then click on the 
Program Log link (purple arrow) to open the animal’s program log. You can then 
remove or modify an upcoming program in order to resolve any conflicts. If you do 
modify an animal’s programs in this way, you can return to the Program scheduler 

Note that an animal with a 
conflict displayed can still be 
selected and scheduled for a 
new program.  RaptorMed 

only highlights the conflicts. It 
is up to the user to avoid or 

resolve them.
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window and press the Reload link (red arrow) to refresh the display and see that the 
conflict has been resolved.

At any time, you can choose a date and print out the reservation sheet for that date by 
pressing the Print reservations link. 

Custom automated alerts
The system allows user-defined alerts to be programmed into the system. These can be 
enabled or disabled on each workstation separately and they allow individual users to 
monitor all types of events or changes in real-time.  Here are some examples:

• Alert for all new admissions today
• Alert for an enclosure temperature or pH out of range
• Alert for al animals in rehab over 180 days.

Any number of alerts 
can be programmed 
(please contact 
customer service for 
assistance).  You can 
specify the importance 
level and which users 
are to be alerted. In the 
Preferences, you can 
specify how often the 
alerts should be 
checked and you can 
turn this feature on and 
off as needed.
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Chapter 6
Miscellaneous functions

Finalizing a patient
Delete last group entry
Exporting releases to a Google map
Bandit integration
Locking a record
Using abbreviations
Group animals
Importing a medical record

Configuring the system
! Preferences
! List choices and locations/enclosures

!
Users
System maintenance
! Increment ages
! Backing up the database
! Settings editor
! Text template editor
! Species editor
! Treatment options editor
! Medication editor

Enclosure editor
! Enclosure medication editor
! Licensing and system information

125



Miscellaneous functions
Finalizing a patient
Once an animal’s final disposition has been established, it’s status must be updated in 
the system.  An animal’s status is set by clicking Patient info in the Action Bar on the 
patient’s chart.  Click here for more information on setting Patient info.  The choices for 
patient status are summarized in this table.

Status Description

DOA dead on arrival

EOA euthanized on arrival

D24 died within 24 hours

E24 euthanized within 24 hours

D died after 24 hours

E euthanized after 24 hours

Reh currently in rehab

R released

PR currently a permanent resident

T transferred

ESC escaped

COA client-owned animal

Only Reh and PR are considered “active” patient statuses.  All others are inactive and it 
is important to properly set the patient Status and Final date in order to remove a 
patient from active status.

Note that if you set the patient status to R or T, then you should also create a Release 
or Transfer record for the patient. 

• Click here for Release records
• Click here for Transfer records
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Client-owned animals (COA) are a special case.  These animals are not considered an 
“active” patient unless the Active patient check box is checked. If this box is not 
checked, these animals are assumed to be away, offsite with their owners and will not 
appear on any daily treatment sheets. In addition, the status of COA animal should 
never be changed. Once COA, they are always COA. Instead, when there is a status 
change, you should use the Sub status field. The Sub status field allows you to select 
from one of the following choices: Died, Euthanized, Escaped, Transferred, or 
Released.  Note that the Final date should also be set when setting the Sub status.

Delete last group entry
This command allows you automatically delete the last record entry for each patient in 
the specified location. This is primarily used to correct a previous data entry error and is 
accessed by right-clicking on the enclosure and choosing Delete last group entry.

Exporting releases to a Google  Map
RaptorMed can export information about past 
releases to a Google Map. This is very useful 
when planning future releases as it helps prevent 
over-crowding of certain species in a certain 
area.  Choose Report ▶ Export releases to 
Google Map from the main menu.  A window will 
appear that allows you to specify: 

• A date range
• Individual species - just enter the species 

codes. Any number can be entered with a 
space between them. If nothing is entered 
here, then all species will be exported.

• The species group can also be specified to 
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export only reptiles, for example.
• You can also select whether to 

display the found location in 
addition to the release location. 

The number of patients  will be 
displayed and then a newly created 
Google Map will be displayed.  Each 
release is indicated by a balloon that is 
color-keyed based on species.  You 
can click on each balloon to view 
information about the animal that was 
released.

Bandit integration
All federal bands that are placed on avian patients prior to release must be reported to 
the Bird Banding Lab (BBL).  This is typically done through the use of the Bandit 
software.  You can manually enter the data into Bandit but this is cumbersome, time-
consuming and error prone.  RaptorMed simplifies this process.  Choose Report ▶ 
Bandit from the main menu.  You will be prompted to enter a date range.  Once you 
specify a range and select a folder to save to, RaptorMed will create a file that contains 
the required information on all the bands used in the specified date range.  You can then 
use the Import command in Bandit to load this data and submit it to the BBL.

To import this data into Bandit version 3.01:
• Choose File ▶ Import from file ▶ Bands/Recaptures from the main menu.
• Choose tab-separated file for the type of tfile.
• Check the Skip first row/Don’t import first row checkbox.
• Choose Matching names for Arrange by.
• Choose Add new records for the Import action.
• Use the various controls on the form to match the column names in the input file with 

what Bandit is expecting.
• Press the Import button.

RaptorMed supports Bandit version 3.01 and 4.0.

Locking a record
A record can be locked against further edit by going to Patient info and checking the 
Locked checkbox. The chart will be marked with banner at the top that says “This 
record is locked and cannot be edited”.
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A record can be unlocked by right-clicking on the animal’s chart in the animal list on the 
main screen. Choose Maintenance ▶ Unlock this patient’s chart.

Note that this function is only available to users with Maintenance privileges.

Using abbreviations
When entering data, you can use predefined abbreviations that will auto-expand to a 
longer block of text.  Abbreviations are available for use in:
• Individual animals medical records
• Enclosure record entries
• Complete blood count results
• Eye examinations
• Surgical reports
• Endoscopy reports
• Flight evaluations

In these forms, you will 
see a Show 
abbreviations link. 
Clicking this will display 
the Abbreviation 
manager screen.  
Abbreviations are 
categorized according 
the list above.
You can select a 
category to view the 
current abbreviations.  
You can add a new 
abbreviation for the 
currently selected 
category by pressing 
the + button and you 
can delete the currently  
selected abbreviation 
by pressing the - 
button.

When you enter an abbreviation into the appropriate form fields, it will be auto-
expanded when the record is saved.

Depending on how your system is set up, there may be a few special abbreviations that 
define specific diets.  From the main menu choose Tools ▶ Define diets.  A window will 
appear that allows you to define an abbreviation for two special diets.  When 
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VEGGIE_MIX or BROWSE is entered in either a individual record entry or an enclosure 
record entry, the abbreviation will be auto-expanded as specified in the Define Diets 
window..

Group animals

This type of animal is not an individual. It represents a group like a school of fish or a 
collection of insects.  Animals are generally managed as a group if you cannot 
distinguish individuals easily.  The actual number of animals in the group is displayed in 
the Notes section at 
the top of the animal’s 
chart. This number can 
be changed using the 
Update census 
command.  The group 
number is actually 
stored in a an attribute 
and any number of 
census counts can be 
stored as shown in this 
example.  The latest 
value is used but the 
previous ones are 
retained for historical purposes.

Groups can  be split and merged as needed.  A split might occur if you move half of the 
individuals of a species from one system to another.  A merge might occur if you move, 
for example, 2 new animals into an enclosure that already contains 5 of the same 
species.  
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To split a group, right click on 
the grouped animal in question 
and choose  Maintenance ▶ 
Split group from the menu.   
You have several options:

• Split out a single animal - in 
this case, a single non-group 
animal record will be created.

• Split out a single group - in 
this case a single group will be 
created of the specified size.

• Split evenly into multiple 
groups - in this case, multiple 
groups will be created.  One 
group may have a few extra 
animals if the number of animals in the original group does not divide evenly by the 
new group size.

In all cases, the new animals will inherit all medical record history from the originating 
animal.

To merge individuals into a new group, right click on the ungrouped animal in question 
and choose  Maintenance ▶ Merge into group from the menu.  The selected animal 
will  be used as the source for all information in the new group.  Note that all animals 
that are to be merged into the group will be deleted. Also note that only animals in 
the same enclosure are considered for merging and animals that are already grouped 
will be ignored.

Animals that that are already in groups can be manually merged into one group. For 
example, if there are 2 groups of fish with 30 animals in group 1 and 20 in group 2, you 
can merge them using the Update Census command.  For the New Count, specify a 
total of 50  for group 1 and then press the Ok button.  Group 1 now has 50 animals and 
you can add a record entry to describe the merge.  Now simply delete Group 2 by right-
clicking on it and choosing Maintenance ▶ Delete this animal/patient.

Importing a medical record
A medical record that was exported in XML format from another RaptorMed database 
can be easily imported by choosing Edit ▶ Import animal record from the main menu. 
The entire record, including all lab results will be copied over and the next patient/
animal id will be assigned to this new animal.  This new record is identical to if you had 
entered all the data manually.
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Configuring your system
Preferences
Choose File ▶ Preferences from the main menu to set preferences and various other 
settings.  A window with several tabs will be displayed. Note that the actual tabs 
displayed depend on the specific privileges of the RaptorMed user that you are logged 
in as. Click here for more information on users and user privileges.  In most cases, you 
will need to press the Apply button before your changes will be activated.  In some 
cases, you may need to restart the program.

Appearance
This tab allows the colors of various areas in the program to be set. Double-click 
on each color to choose from a color-picker.

• Main window - This sets the color of the Patient list and the Enclosure list in 
the main window.

• Record entry background - This sets the color of the main text edit area in 
the medical record entry form as well in other forms throughout the program.

• Patient snapshot - This sets the color of the patient snapshot popup window.
• Patient record accent - This sets the color of the accented areas in the main 

patient record display.
• You can also choose the font size that is used in the lists in the Main Window 

and on most printouts. If you leave these blank, then the default system font 
will be used.  As a point of reference, the default size is typically around 10, a 
font size of  8 is very small and 18 is very large.

• The default zoom level that is used when you preview the various printouts 
before actually printing them.
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Miscellaneous
This tab allows the following settings to be configured:

• Patient of the week - This 
determines which patient will 
be showcased on the 
RaptorMed web page.

• Ideal weight - Each patient 
can have an ideal weight 
specified for the summer 
and/or winter.  See Patient 
info for details.  This weight 
is displayed as an “ideal 
weight band” on the patient’s 
weight chart.  This setting 
allows you to choose which 
weight will be used for the 
weight band display.  This 
setting should be updated 
based on the season.

• Show record entry timestamps - If this is checked, then the last date and 
time that a record entry was updated will be displayed in the patient’s record.

• Debug mode - For internal use only.
• Use cage card printer - If this is checked, the dedicated cage card label 

printer function is enabled.
• Auto-expand location list - if checked, then each entry in the Enclosure List 

on the main screen will be expanded to display each animal in each 
enclosure.

• Show alerts - If this is checked, then the Alert function will be started and will 
run in the background.  You can specify the interval (in seconds) for how often 
the alerts will be checked.
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Email
These settings are used to configure the 
function that allows RaptorMed to 
automatically sends emails for various 
situations.  Click here for details.  These 
settings are typically configured when the 
system is installed and should not need to 
be changed.

Network connection
Each RaptorMed workstation needs to have access to a few shared folders on 
the RaptorMed server machine.  In most instances, this access will be 
established automatically by Windows 
when you log onto your machine.  In 
some cases, this does not occur and 
this tab allows you to manually 
configure access to these folders.

Check the Separate network 
connection required checkbox if this 
is necessary.

A drive letter must be specified in order 
to access to the shared folders. It 
should be a letter that is not already in 
use.

Enter the Windows login username and password required to access these 
folders. The username may need to be provided as a DomainName\Username 
pair. Your network administrator may need to provide this.

You will need to restart RaptorMed for the changes to take place.  When 
RaptorMed starts a command-prompt window will popup momentarily as the 
connection to these folders is established.  As a test, try to view any image for an 
existing patient.  If you can view an image, then you have configured this 
properly.  If the images for any patient do not appear, then you may have entered 
the wrong username or password.
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List choices
There are lists to choose from throughout the program.  In 
general, the choices in these lists are configurable.  To edit 
these choices, select Edit ▶ List choices from the main 
menu.  A window will appear that allows you to select the 
category/list you want to edit.  You can add a new entry by 
pressing the + button.  You can delete the selected choice 
by pressing the - button and you can edit the selected choice 
by double-clicking it.  In addition, you can copy the selected 
Location by pressing the Copy button (indicated by the 
arrow in the screenshot).  The following category/lists can be 
edited:

• Age - Used to specify the patient age on admission and 
the current age.

• Chemistry source - Used to specify the source of the results for 
blood chemstries.

• City - Used to specify where an animal was found or released and for making 
entries in the Address Book.

• Clinicians for consult - Used to schedule a consult with a specific clinician on the 
treatment sheet.

• Collection method - The methods used by aquariums to capture fish from the wild.
• Collection vessel - The vessels/boats used by aquariums to capture fish from the 

wild.
• Consult - Used in the individual treatment plan to specify a service or hospital 

section that is needed to perform a consult.
• County - Used to specify where a patient was found and for making entries in the 

Address Book.
• Crude type - The different types of oil involved in spills.
• Dosage units - The units used to specify a dose per kg. Used by the Medication 

Editor when setting up a dosage for a liquid drug.  The typical value is ml.
• Ear medication type - These are the choices available when ordering ear 

medications on the treatment sheet.
• Eye antibiotic - These are the choices available when ordering ophthalmic 

antibiotics on the treatment sheet.
• Eye NSAIDs - These are the choices available when ordering ophthalmic NSAID 

medications on the treatment sheet.
• Fecal parasites - Used when recording results of fecal examinations.
• Formula - These are the choices available when ordering formula on the treatment 

sheet.
• Image type - Used to specify the type of image when a new image is dragged and 

dropped onto a patient’s chart.
• Injury cause - Used to specify the cause of injury.
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• Inventory units - Used by the Inventory manager. These are the units of measure 
for the different supply items.

• Keyword - Used to save special keywords in the patient’s chart. These can be used 
to search for patient’s with special problems or that were treated with special 
treatments.

• Lab results source - Used to record the source (i.e. lab or instrument) that 
generated the results of a specific sample test.

• Lab test - Used to specify a lab test that was run on a sample.
• Location - Used to configure each separate enclosure or cage for housing patients.
• Patient attributes - Each animal can have any number of attributes that store 

miscellaneous information. Each attribute must have a name and these are 
configured here.  See Patient attributes.

• Patient skill level - Used to specify the skill level required to do a treatment on a 
particular patient.  This option may not be available in all installations.

• Problem - Used to record the various problems and diagnoses.
• Program ages - These are the age categories used to record attendance at a 

program
• Program type - These are the types of presentations that can be utilized when 

doing a program. 
• Release id type - Used to specify the type of release identification device that was 

used when a patient is released. Typical choices include Leg band and ear tag. This 
choice is made on the Release form.

• Reason for euthanasia - Used to specify the reason that a euthanasia was 
performed.

• Reminder category - Used to categorize reminders. They can be any descriptive 
text such as a department or person’s name and can be used to sort the reminders 
in the Reminder Viewer.

• Sample type - Used to specify the type of sample (i.e. blood, biopsy, etc.).
• Species group - Used to specify a group of species such as avian, avian:raptor, 

avian:songbird, or mammal. Note that the species groups are hierarchical and each 
sub-category is separated by a colon.

• Stain - Used to specify the stain that was used in preparing a cytology slide.
• State - Used to populate all the lists that allow a state to be chosen.
• Surgical procedure - Used to specify the procedure that is described in a surgical 

report.
• Tag type - The type of tag used to identify aquatic animals. PIT tag is the most 

common choice for this.
• Taxonomy_xyz - These are used to fill the taxonomy lists in the Species Editor. 

There are separate lists for kingdom, phylum, class, order and family.
• Tracker type - Used the specify the type of tracking device that may have been 

used when a patient is release.  This choice is made on the Release form.
• TrainingXYZ - These are used to fill the various fields on the Training form. There 

are separate lists for behavior, bridge type, flight type, reinforcement type and target 
type.
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• Transfer reason - These are added to the Reason list on the Transfer form.
• Urinalysis clarity - Used to record urine clarity.
• Urinalysis color - Used to record urine color.
• Urinalysis test results - Used to record the results for the various tests in a 

urinalysis panel.
• Vitamin type - Used to specify the type vitamins that are to be used in individual 

treatment plan.  Not currently used.

All category list values except for the Location are simple text.  For each Location, a 
special form appears that allows you to configure various properties about the location. 
See Enclosure editor for more information.
! !
Admission questions
The system can be configured so that the person delivering an animal can be asked a 
series of pre-determined questions. Up to five questions can be asked and they have 
must be set up in the following format:

Question? [answer1,answer2,etc]
For example:

How did you hear about this wildlife center? []
Would you like to be placed on our mailing list? [yes,no]

In the first case, the answer is free-form and you can type in anything. In the second, 
case,  you must choose from one of the preset answers. The fourth question is special 
in that it drives the Outstanding disposition letter function. Any animal with a YES 
answer for Question 4 will be included on this report.

Users and user privileges
Users can be managed by choosing File ▶ User manager from the main menu.  
Currently you must be logged into RaptorMed as a special user whose login name is 
root. This user is setup when the system was installed.  It should only be used when 
you need to manage or add a user; not for day-to-day use.
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You can add a user by 
pressing the + button and you 
can remove the selected user 
by pressing the - button.  To 
edit a user, just double-click 
on it.

You can select any number of 
privileges for a user.  It is 
always best to select only the privileges that are absolutely needed for that user.   

A typical user should have View, Add/
update, and Delete privileges.  You 
may also want to grant Add patient 
privileges.  Only administrator or 
management-type users should have 
User management or Maintenance 
privileges.

The Requires review option means 
that this user’s entries need to be 
approved by a supervisor in order be 
considered finalized.  Entries made by 
these users that include anything 
other then simple text (i.e. lab results, 
any attachment, or data entered via a data-entry form) will have be automatically given 
an entry type of of.  These entries will remain in this state until a supervisor has 
reviewed them. See the Entries that need review function for more information.  Note: 
this review process applies to entries made in an animals chart as well as entries made 
in an enclosure’s log.

Note that Delete privileges only allows a user to delete a specific single entry.  It does 
NOT allow a user to delete a patient or an entire record entry. This requires a user with 
Maintenance privileges.
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Maintenance
The Maintenance menu is only available to RaptorMed users with Administrator 
privileges.  Click here for more information on User privileges. This menu contains the 
following areas that allow for the system to be configured and maintained. 

Increment ages
This command can be used to update the age of each active patient.  It currently only 
works for patients whose ages are specified using the age scheme utilized by the USGS 
Bird Banding Lab (BBL).  Specifically, ages such as L, HY, AHY, SY, TY, 4Y, 5Y, 2, 2+ 
will be properly incremented but other age values will be ignored.  As birds are deemed 
to have aged one year on Jan 1, this command should be run in early January.  Note 
that this command cannot be undone so you will be prompted twice to proceed before 
the operation will take place.  

Update license key
This command allows a new license key to be entered. See Licenses below.

Backing up the database
The database should be backed up frequently.  In order to do this, you can access the 
Backup Wizard by choosing Tools ▶ Maintenance ▶ Backup database from the main 
menu.  Note that you must have Maintenance privileges to access this function.  Click 
here for more information on User privileges.

Notes: 
In order to run this command, the Windows user that you are logged in as must 
have Administrator rights on the computer.  This is sometimes complicated, 
especially on Windows 7, so you may need assistance from your network 
administrator.  
Also realize that the database will be offline for the short period of time that is 
required to perform the backup, so you should plan to do the backup during a 
slow period or after hours.

When you press Step 1, a 
window will pop up 
momentarily.  This stops the 
database and the green light 
should change to red.  If the 
color does not change, then 
your Window’s user account 
probably does not have the 
correct access rights.
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Once the light has turned red, press Step 2.  This automatically opens each folder that 
has data that needs to be backed up.  This is done as a convenience for you but the 
actual backup procedure that you must perform depends on if you are burning the data 
to a CD/DVD or copying it to a secure network drive.  

Once the backup procedure is complete you can close all the folders that were opened 
in Step 2 and press Step 3.  A window will popup again to restart the database and the 
light should turn back to green.   At this point, the backup procedure is complete.  

You can view the history of all backups by choosing Help ▶ About from the main menu.  
A list of all database maintenance, including backups and updates, will be displayed.

Settings editor
The Settings editor is used to 
do maintenance or make 
configuration changes to the 
database.  It is accessed by 
choosing Tools ▶ 
Maintenance ▶ Settings 
editor from the main menu.  
This function is generally for 
internal use only or should 
only be used under direction 
from RaptorMed technical 
support. Note that you must 
have Maintenance privileges 
to access this function.  Click 
here for more information on 
User privileges.

Text template editor
The text stings that can be automatically inserted into a medical record are listed at the 
top of the list on the right-hand side of the medical record entry form and also in the 
Enclosure Log entry form.  These can be edited using this tool that is accessed by 
choosing Tools ▶ Maintenance ▶ Template editor.
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A window is displayed that displays each template. 

Select a template by choosing one from the list.  You can edit the template’s text that is 
displayed in the large edit fields.

Add a new template by pressing the + button.
Remove a template by pressing the - button.
Rename a template by pressing the Rename link.
In addition, you can specify whether this template should be available for individual 
patient record entries and/or enclosure record entries by checking the appropriate 
boxes.
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Species editor
This list of species programmed into the system can be edited and modified as needed. 
These can be edited using this tool that is accessed by choosing Tools ▶ Maintenance 
▶ Species editor. To add a new species, press the + button.  To edit an existing 
species, double-click on it. To delete the selected species, press the - button. Note that 
you can select more than one species using the shift and control left-click key 
combinations.  You can sort the list by clicking on each column heading.  Note that N or 
D stands for Nocturnal or Diurnal.

You remove any unused entries from the list by pressing the Delete unused species 
link.

When adding or editing a species, the following form appears.  There are fields for the 
Abbreviation, Common name, Scientific name, and you can specify whether the 
species is Native or not and whether it is Diurnal or Nocturnal.  

You can specify whether this species is a Species of concern (i.e. threatened or 
endangered) in your state or nationally.  This is important because the system will 
remind you to report species of concern when admitted.  

You can specify if this is a Highly Migratory Species (important when creating HMS 
reports) and the system can optionally alert you (when the animal is admitted) to record 
the proper biometric data that is required for the HMS reports.

You can specify if this is a Rabies Vector Species and the system can optionally alert 
you (when the animal is admitted) with a custom message that can provide additional 
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instructions that may be required. For example, your state or county may require 
additional information or paperwork to be be filled out and this optional alert message 
can provide the proper guidance.

You can specify if this is a Venomous Species and an alert banner will be automatically 
printed on the animal’s cage card and on the main medical record page.

For birds, the four-letter abbreviations specified by the USGS Bird Banding Lab (BBL) 
are typically used, although, this is not absolutely required.  For non-avian patients, you 
can used any scheme that works for you.  Many facilities use the genus/species as the 
basis of the abbreviation.  For example, the opossum is Didelphis virginiana so its 
abbreviation could be DIVI.  Another option is to create easily recognized abbreviations 
for a species so the opossum could be OPOS.  Any abbreviation can be used as long 
as two species do not have the 
same abbreviation. 

The Habitat can also be 
specified. This may be important 
for various reports.

If enabled on your system, you 
can also specify the entire 
Taxonomy from Kingdom to 
Species.

You can specify an Information 
page/URL as well. This page will 
be displayed when the user right-
clicks on a patient and chooses 
Show species info page.  Note 
that Wikipedia has a very good 
set of pages for a wide range of 
species.  The prefix http:// is not needed.

The Cost category is used by the Cost Estimator function and this setting helps 
determine the per day cost for a patient of a particular species.

The Value field can be used to assign a monetary value to a specimen of this species.  
This is used in the Collection Value Report.

Click here to 
automatically go to the 
USGS BBL page of 
abbreviations.
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Treatment options editor
The Treatment Options Editor allows you to 
choose which non-medication options are 
present on the treatment plan sheet.  The editor 
is accessed by choosing  Tools ▶ 
Maintenance ▶ Treatment options editor 
from the main menu.  It is divided into sections 
based on the species group so there is a 
section for avian, reptile, mammal, etc.  This 
allows you to configure different options for 
each species group. This is important since it 
does not make sense to have “Feather check” 
on the treatment sheet for a turtle, for example.  
There are the following general categories:  
Food, Fluids, Eyes, Ears and Miscellaneous.  
Click on each section and choose the options 
you want.  When you are done, press the Ok 
button. You must restart the program before 
any changes made here will take effect.

Medication editor
The medications listed on the individual treatment sheets can be configured using this 
tool that is accessed by choosing Tools ▶ Maintenance ▶ Medication editor.  The 
following window will appear.  It is divided into two main sections. The left side lists each 
medication and they are divided into four main categories:

• Antibiotics
• Analgesics, NSAIDs, etc.
• Other meds
• Vaccines

The right side lists the dosage formulary for each drug and it is organized in a nested 
arrangement based on the species group. For example, avian:raptor is listed below 
avian. This means that you can have a separate formulary for avian:raptor vs 
avian:songbird.
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You can edit an existing medication by double-clicking any entry in the list on the left 
side. You can add or remove the selected medication by pressing the + and - buttons.  
When adding a new medication it will be added to the category that is currently 
selected.

The medication editor form is displayed when editing or adding a medication.  The 
following fields are on this form:

• Name - the name that will appear on the treatment sheet.  Note that spaces are not 
allowed. If you enter a space it will be replaced with an underscore.

• Select checkbox - check this box if you want this medication to be available on the 
treatment plan form.

• Generic checkbox - check this box if this is a generic drug.
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• The Forms list - specify any 
number of different drug 
forms/concentrations.  
Double-click on an entry to 
edit it. Press the + and - 
buttons to add and remove 
choices. Press the * button 
to mark the selected choice 
as the default.

• The Routes list - specify any 
number of different delivery 
routes.  Press the + and - 
buttons to add and remove 
choices. Press the * button 
to mark the selected choice 
as the default.

• The Frequencies list - 
specify any number of 
different delivery 
frequencies.  Press the + 
and - buttons to add and 
remove choices. Press the * button to mark the selected choice as the default.  Valid 
choices are SID, BID, TID and dates where dates indicates that individual dates can 
be specified.

• Use until date checkbox - check this box if you want this medication to allow an Until 
date to be specified.

• Number of dates - specify the number of individual dates that can be entered.  This is 
only relevant if you have selected “dates” as an option in the Frequencies list.

• On click event - allows you to specify an action that will occur when this medication is 
selected.  The choices are:

• approvalRequired - this will force the user to enter the initials of the person that 
has  approved the use of this drug.

• fluids - this will prompt the user to setup a fluid protocol and is typically used for 
nephrotoxic drugs.

You can edit an existing dosage by double-clicking any entry in the list on the right 
side. You can add or remove the selected dosage by pressing the + and - buttons.  
When adding a new dosage it will be added to the species group that is currently 
selected or to the species group that contains the dosage that is currently selected.

The dosage editor form is displayed when editing or adding a dosage.  The following 
fields are on this form:
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• Name - Choose the name from the list. The names in this list must have already been 
setup as shown above in the medication list.

• Form - When you select a medication name, the list of available forms will be listed.
• Frequency - the dosage frequencies that this dosage applies to.  You can list more 

than one separated by a comma. For example: SID, BID, TID
• Route - the dosage route that this dosage applies to.  You can list more than one 

separated by a comma. For example: SQ, IM, IV
• Planned dosage - the intended dosage in mg/kg.
• Type

• calc - This is used for liquid medications that can be dosed exactly by calculating 
the dose based on the animal’s weight and the concentration of the liquid.  The 
dose is calculated by multiplying the animals weight in kg by the Actual dosage 
specified in the Actual dosage fields.  For example: if the weight is 2 kg and the 
Actual dosage is specified as 0.35 ml, then the dose would be 0.7 ml.  If the Form 
is listed in a mg/ml format,  and you enter the planned dosage in a mg/kg 
format, then the Actual dosage field will be auto-filled for you.

• closestMatch - This is used for tablets and capsules that cannot be divided easily. 
If this choice is selected, the Actual dosage fields are ignored. Instead a 
spreadsheet is used that allows you to specify a dose that most closely matches 
the animal’s weight. So for example, you could specify that  250 g animal gets 1/4 
tab,  a 500 g animal gets 1/2 tab, etc.  The program will find the closest match 
based on weight.  You can make the weight increment between entries as small or 

The form is 5 mg/ml

The dosage is 0.5 mg/kg

The actual dosage is 
auto-calculated
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as large as is needed for this particular medication.  The following is a typical 
example.

Note that it is good practice, as is shown in this example, to include a dose of NA (not 
applicable) for a weight that is too small or too large to be effectively dosed by this 
medication form. If this is done, then the auto-calculator will display NA when this drug 
is selected and this will indicate to the user that another drug form must be used.  In 
reality, this is a very common situation as tablets and capsules can typically only be 
divided into halves or quarters but rarely anything smaller.

You can right click on the dosage spreadsheet to Clear all previously entered dosages 
and to automatically insert a range of weights.  When auto-inserting a weight range, 
you will be prompted for the min weight, the max weight and the increment in weight 
between entries. All weights are in grams.  Note that NA will automatically  be inserted 
in the Dose column for the first and last entry.  You can always override this but it is 
good practice to have NA at the top and bottom of the weight range.

At any time, you can backup the medication formulary by pressing the Backup link.  As 
the process of editing the formulary is somewhat detail-oriented, it is not a bad idea to 
perform a backup before making any edits.  When you make a backup, the formulary is 
stored in a file that contains the date and time.  If an error is made, you can easily 

Notice the Dose is 
NA. This is done so 
that you will be 
clearly alerted when 
there is no pre-
determined dose for 
an animal on the low 
end of the weight 
range.
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restore a saved backup by pressing the Restore link. When restoring a formulary from a 
backup, you will be prompted to choose from a list of previously saved backups.

Enclosure editor
The enclosures can be configured using this tool. It is accessed by choosing Tools ▶ 
Maintenance ▶ Enclosure editor.  A list of all currently defined enclosures is 
displayed.  The Display order is also 
shown.  This is the order that the 
enclosures are listed in the 
Enclosure List on the main screen.   
This is typically alphabetical, but they 
are be ordered in any manner that 
makes sense to your operation.  The 
Display order for the selected 
enclosure can be changed by 
pressing the Up and Down arrows.

You can add a new enclosure or 
delete the selected one by pressing 
the + and - buttons, respectively.  You 
can edit an enclosure by double-
clicking on it and you can copy the 
selected enclosure by pressing the 
Copy button (the center button).  

When creating a new enclosure or when copying or editing and existing enclosure, the 
Location/enclosure info form is displayed. The form allows you to set many properties 
for each locations. These include:

• Name - The name of the enclosure.  This can be simply a number or a more 
descriptive name.  Note that apostrophes are not allowed in the name.

• Description - A description of this enclosure. For information purposes only.
• Dimensions - The enclosure dimensions. This is displayed in the Enclosure list on 

the main screen and is for informational purposes only.
• Capacity - The enclosure capacity (i.e. the number of animals that can comfortably 

be houses in this location).  This is displayed in the Enclosure list on the main 
screen and is for informational purposes only.

• Special - Any special notes about this enclosure.  This is for informational purposes 
only.

• Alert text - This text will be printed on the daily treatment sheets and can be used 
as an alert or reminder about something specific about this cage. For example, you 
could say something like “Be careful with door latch” or “CAREFUL - AGGRESSIVE”.

• Lock -  Indicates whether this enclosure has a lock.  If you enter the lock information 
(such as the combination lock code), it will print out on the daily treatment sheets.
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• Curator - The curator/aquarist is the person responsible for this enclosure. If 
enabled, the Enclosure List on the main screen can be filtered by this field.

• Department - This is the name of the section in your organization that this enclosure 
belongs to. If enabled, the Enclosure List on the main screen can be filtered by this 
field.

• There are also several check boxes that determine how this location is used and 
interpreted by RaptorMed.
• Kennel room - This indicates this location is a room full of separate kennels or 

enclosures.  If this box is checked, then each animal in this location will be 
treated as an individual.  If this box is not checked, then all patients in this 
location will be treated as a group.

• Under construction - If checked, this location will be highlighted in the 
Enclosure list and on the Site Map.  This is for informational purposes only and 
the program does not prevent you from putting a patient in a location that is 
under construction.

• Inactive - If this box is checked, this location will be removed from all lists and it 
cannot be selected or used for patients until unchecked.

• Offsite - These locations are for enclosures that are not on the premises and can 
be used for patients that are currently “on loan” to another organization or are 
otherwise offsite.  Offsite locations are not included in the main Enclosure list.

• Fresh water and Salt water - Used to indicate that this enclosure is aquatic.  
Water quality data can be recorded for these enclosures. 

• Inside and Outside - These allow you to specify whether the enclosure is inside 
or outside.  Depending on your configuration, this may determine where patients 
in these locations will appear on the daily treatment sheets.
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• On Exhibit - This enclosure is on display and will be part of the Exhibit census 
report.

• Under treatment - This is used to indicate that a system is under treatment. This 
is very useful in aquarium situations where a tank of newly captured fish 
are being treated during a quarantine period.  Enclosures in this 
situation are marked with a red dot in the center of their symbol in the 
Site Viewer.  There will also be an UNDER TREATMENT text banner 
across the top of the Enclosure Log screen.

• Pending issue - The check box can be used to mark an enclosure as having an 
unresolved issue.  This checkbox may be used in your daily treatment printouts.

• Dirty - This is used to indicate that an enclosure is dirty and should not be used. 
It will display as an orange dot on the Site Viewer.

• Volume - The volume of the tank. This is important for aquatic enclosures and is 
used to auto-calculate enclosure medication dosages.

• Flow rate -  For aquatic enclosures. For informational purposes only.
• Feed order - This number indicates the order that this location will appear on the 

daily treatments sheets.  Typically, it makes sense to set the feed order so that the 
order mimics the route that somebody would walk to visit each location. It is a 
decimal number so that you can add a new location between two existing ones 
easily. For example, if Cage 1 and Cage 2 have feed order 2.4 and 2.5 respectively, 
you can add a new location called Cage 1a with a feed order of 2.41.

• Display order - This number indicates the order that this location will appear in the 
Enclosure list on the main screen.  Typically, it makes sense to set the display 
order so that each location is in alphabetic 
order.  As with the Feed order, this number is 
a decimal number so that you can easily insert 
a new location between two existing ones.

• X Coord - This is the horizontal coordinate of 
the location on the Site Map. 0,0 is in the 
upper left corner.

• Y Coord - This is the vertical coordinate of the 
location on the Site Map. 0,0 is in the upper 
left corner.

Enclosure medication editor
The medications listed on the enclosure treatment sheets can be configured using this 
tool. It is accessed by choosing Tools ▶ Maintenance ▶ Enclosure/system 
medication editor.  The following window will appear.  It is divided into two main 
sections. The left side lists each medication and the right side lists the dosages.

To easily set the coordinates for a 
location, Shift-left click on a spot 

on the Site Map.  A purple spot 
will be displayed.  Shift-left click 

until the purple spot is in the 
correct location. Then press the 
“Copy coords from site map” 

link.
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You can edit and existing medication by double-clicking any entry in the list on the left 
side. You can add or remove the selected medication by pressing the + and - buttons.  

The medication editor form is displayed when editing or adding a medication.  The 
following fields are on this form:

• Name - the name that will appear on the treatment sheet.  Note that spaces are not 
allowed. If you enter a space it will be replaced with an underscore.

• Select checkbox - check this box if you want this medication to be available on the 
treatment plan form.

• Non-releasable checkbox - check this box if this is a drug that should result in any 
animals being marked as non-releasable after being treated with this drug.
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• The Forms list - specify any number of different 
drug forms/concentrations.  Double-click on an 
entry to edit it. Press the + and - buttons to add 
and remove choices. Press the * button to mark 
the selected choice as the default.

• The Frequencies list - specify any number of 
different delivery frequencies.  Press the + and - 
buttons to add and remove choices. Press the * 
button to mark the selected choice as the default.  
Valid choices are SID, BID, TID and dates where 
dates indicates that individual dates can be 
specified.

• Use until date checkbox - check this box if you 
want this medication to allow an Until date to be 
specified.

• Number of dates - specify the number of 
individual dates that can be entered.  This is only 
relevant if you have selected “dates” as an option in the Frequencies list.

You can edit and existing dosage by double-clicking any entry in the list on the right 
side. You can add or remove the selected dosage by pressing the + and - buttons.  

The dosage editor form is displayed when editing or adding a dosage.  The following 
fields are on this form:

• Name - The name of the medication is chosen from the list
• Form - This list is filled with available choices when a medication is chosen from the 

above list.
• Frequency - the dosage frequencies that this dosage applies to.  You can list more 

than one separated by a comma. For example: SID, BID, TID.
• Planned dosage - the intended dosage in mg/L. If the Form is specified in a mg/ml 

format and the Planned dosage is provided in mg/L format then the Actual dosage 
will be auto-calculated in a ml/L format.

• Actual dosage - Specify the amount here. The volume units for the dose and the 
units for the destination aquarium must be specified are you can have the system 
auto-calculate the value for you as described above.
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At any time, you can backup the medication formulary by pressing the Backup link.  As 
the process of editing the formulary is somewhat detail-oriented, it is not a bad idea to 
perform a backup before making any edits.  When you make a backup, the formulary is 
stored in a file that contains the date and time.  If an error is made, you can easily 
restore a saved backup by pressing the Restore link. When restoring a formulary from a 
backup, you will be prompted to choose from a list of previously saved backups.

Open shared folder
This function will open the Windows File Manager in the RaptorMed shared folder. This 
is simply a convenience function and is useful when doing maintenance or debugging 
issues.

The Form is in mg/ml

The Planned dosage is in 
mg/L

so the Actual dosage can 
be auto-calculated in ml/L
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Licensing and system information

RaptorMed requires an active license in order to run.  
The license is renewed on a periodic basis as 
determined by the purchase agreement.  The current 
license expiration date is shown in the About box that 
is displayed when you select Help ▶ About from the 
main menu.

In addition, this window displays the network IP 
address or hostname of the RaptorMed server and 
the status of the RaptorMed shared folder 
resource.  These can be helpful when debugging 
problems that you may encounter.

The list at the bottom is a maintenance log that displays 
information about events such as database backups, 
additions of new users and when animal records are 
deleted.
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